
BM/QT10/P.ĐTSV/04/04 

 Ban hành lần: 3 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

UBND TỈNH BÀ RỊA – VŨNG TÀU 

TRƯỜNG CAO ĐẲNG KỸ THUẬT CÔNG NGHỆ 

 

 

 

 

 

 

 
 

 

 

GIÁO TRÌNH 
MÔ ĐUN QUẢN TRỊ HỆ THỐNG WEBSERVER VÀ MAILSERVER 

NGHỀ: QUẢN TRỊ MẠNG 

TRÌNH ĐỘ: CAO ĐẲNG  

 

(Ban hành kèm theo Quyết định số: ……/QĐ-CĐKTCN, ngày … tháng … năm 

20…… của Hiệu trưởng Trường Cao đẳng Kỹ thuật Công nghệ BR-VT) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Bà Rịa – Vũng Tàu, năm 2020 
 

 

 



  

2 
 

TUYÊN BỐ BẢN QUYỀN 

 

Nhằm đáp ứng nhu cầu học tập và nghiên cứu cho giảng viên và sinh 

viên nghề Công nghệ Thông tin trong trường Cao đẳng Kỹ thuật Công nghệ 

Bà Rịa – Vũng Tàu, chúng tôi đã thực hiện biên soạn tài liệu Quản trị hệ 

thống WebServer và MailServer này. 

Tài liệu được biên soạn thuộc loại giáo trình phục vụ giảng dạy và học 

tập, lưu hành nội bộ trong Nhà trường nên các nguồn thông tin có thể được 

phép dùng nguyên bản hoặc trích dùng cho các mục đích về đào tạo và 

tham khảo. 

Mọi mục đích khác mang tính lệch lạc hoặc sử dụng với mục đích 

kinh doanh thiếu lành mạnh sẽ bị nghiêm cấm. 
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Tôi xin cảm ơn các thầy cô khoa CNTT–Trường Cao đẳng Kỹ thuật 

Công nghệ đã cho tôi các ý kiến đóng góp quý báu để tôi hoàn thiện giáo trình 
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GIÁO TRÌNH MÔ ĐUN  

 

Tên mô đun: Quản trị hệ thống Webserver và Mailserver 

Mã môn học/mô đun:MĐ19 
 

VỊ TRÍ, TÍNH CHẤT CỦA MÔ ĐUN: 

- Vị trí: Mô đun được bố trí sau khi sinh viên học xong các môn học chung, 

trước các môn học, mô đun quản trị mạng, quản trị mạng nâng cao. 

- Tính chất: Là mô đun chuyên ngành đào tạo bắt buộc, cung cấp các kiến thức 

về quản trị hệ thống WebServer và MailServer. 

MỤC TIÊU MÔ ĐUN: 

- Về kiến thức: 

+ Trình bày được tổng quan về hệ thống Web; 

+ Trình bày được các khái niệm về hệ thống thư điện tử; 

+ Quản trị được hệ thống MailServer; Webserver 

- Về kỹ năng: 

+ Cài đặt và quản trị được hệ thống Web Server; 

+ Cài đặt và quản trị được hệ thống FTP Server; 

+ Cài đặt và cấu hình được hệ thống MailServer; 

+ Xử lý và  khắc phục sự cố của hệ thống Web Server, FTP Server và Mail 

Server; 

- Về năng lực tự chủ và trách nhiệm: 

+ Có thể làm việc độc lập hoặc theo nhóm trong việc quản trị hệ thống 

webServer và MailServer 

+ Bố trí làm việc khoa học đảm bảo an toàn cho người và phương tiện học 

tập. 

NỘI DUNG MÔ ĐUN: 

 

BÀI 1. TỔNG QUAN VỀ MỘT HỆ THỐNG WEB 

Mã bài: 19.1 

  

Mục tiêu: 

- Biết được mô hình tổng quan về hệ thống web; 

- Hiểu được nguyên tắc hoạt động của hệ thống web. 

- Thực hiện các thao tác an toàn với máy tính. 

Nội dung chính: 

2. Giới thiệu web server  

Máy Web Server là máy chủ có dung lượng lớn, tốc độ cao, được dùng để 

lưu trữ thông tin như một ngân hàng dữ liệu, chứa những website đã được thiết 

kế cùng với những thông tin liên quan khác. (các mã Script, các chương trình, và 

các file Multimedia) 



 

 

8 
 

Web Server có khả năng gửi đến máy khách những trang Web thông qua 

môi trường Internet (hoặc Intranet) qua giao thức HTTP – giao thức được thiết 

kế để gửi các file đến trình duyệt Web (Web Browser), và các giao thức khác. 

Tất cả các Web Server đều có một địa chỉ IP (IP Address) hoặc cũng có thể 

có một Domain Name. Giả sử khi bạn đánh vào thanh Address trên trình duyệt 

của bạn một dòng http://www.abc.com sau đó gõ phím Enter bạn sẽ gửi một yêu 

cầu đến một Server có Domain Name là www.abc.com. Server này sẽ tìm trang 

Web có tên là index.htm rồi gửi nó đến trình duyệt của bạn. 

Bất kỳ một máy tính nào cũng có thể trở thành một Web Server bởi việc cài 

đặt lên nó một chương trình phần mềm Server Software và sau đó kết nối vào 

Internet. 

Khi máy tính của bạn kết nối đến một Web Server và gửi đến yêu cầu truy 

cập các thông tin từ một trang Web nào đó, Web Server Software sẽ nhận yêu 

cầu và gửi lại cho bạn những thông tin mà bạn mong muốn. 

Giống như những phần mềm khác mà bạn đã từng cài đặt trên máy tính của 

mình, Web Server Software cũng chỉ là một ứng dụng phần mềm. Nó được cài 

đặt, và chạy trên máy tính dùng làm Web Server, nhờ có chương trình này mà 

người sử dụng có thể truy cập đến các thông tin của trang Web từ một máy tính 

khác ở trên mạng (Internet, Intranet). 

Web Server Software còn có thể được tích hợp với CSDL (Database), hay 

điều khiển việc kết nối vào CSDL để có thể truy cập và kết xuất thông tin từ 

CSDL lên các trang Web và truyền tải chúng đến người dùng. 

Server phải hoạt động liên tục 24/24 giờ, 7 ngày một tuần và 365 ngày một 

năm, để phục vụ cho việc cung cấp thông tin trực tuyến. Vị trí đặt server đóng 

vai trò quan trọng trong chất lượng và tốc độ lưu chuyển thông tin từ server và 

máy tính truy cập. 

Phần lớn các server sử dụng một bộ ánh xạ cổng chuẩn, và một vài 

cổng thông dụng được mô tả ở bảng 1. Phần lớn các Web server sử dụng cổng 

80, nhưng ta có thể thay đổi để Web server có thể cài đặt trên cổng không tiêu 

chuẩn. Nếu muốn "dấu" Web server như là một Web server đa host trên một 

máy tính bằng việc ánh xạ mỗi server cho một cổng khác nhau. Chú ý, nếu sử 

dụng một ánh xạ cổng phi chuẩn, người sử dụng sẽ cần biết số cổng mới của bạn 

để có thể kết nối tới server của bạn. 

20  FTP, File Transfer Protocol 

21  FTP, File Transfer Protocol 

23  Telnet 

25 SMTP, Simple Mail Transfer Protocol 

53  DNS, Domain Name Service 
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70  Gopher 

80  HTTP, Hyper Text Transfer Protocol (the protocol used by 

the World Wide Web) 

107  Remote Telnet service 

109  POP2, Post Office Protocol version 2 

110  POP3, Post Office Protocol version 3 

119  NNTP, Network News Transfer Protocol 

143  IMAP4, Interactive Mail Access Protocol version 4 (used to 

be used by IMAP2) 

194  IRC, Internet Relay Chat 

220  IMAP3, Interactive Mail Access Protocol version 3 

389  LDAP, Lightweight Directory Access Protocol 

443  HTTPS, HTTP running over secure sockets 

540  UUCP, UNIX to UNIX Copy 

1.1. Vai trò của Web server 

Trước kia, truy cập từ xa các đoạn mã nhị phân đòi hỏi những giao 

thức thuộc sàn diễn đặc trưng. Ví dụ như DCOM, DCOM client truy cập các 

kiểu dữ liệu COM từ xa sử dụng thủ tục gọi từ xa RPC (Remote Procedure Call) 

được gán kết chặt chẽ. 

Một trong các hạn chế của DCOM là không thể vượt qua tường lửa 

(firewall). Do vậy, Web server là cách khắc phục nhược điểm này. Bằng cách sử 

dụng Web server ta có thể truy cập assembly sử dụng HTTP mà thôi. Trong tất 

cả các nghi thức hiện có, truy xuất thông tin và điều khiển quá trình công nghệ 

trên nền tảng Web HTTP là một nghi thức liên lạc đặc thù mà tất cả mọi trình 

duyệt đều chấp nhận hỗ trợ. 

Như vậy, sử dụng Web server, người triển khai Web server có thể sử 

dụng bất cứ ngôn ngữ nào mình muốn. Người dùng Web server có thể dùng 

HTTP chuẩn để gọi các hàm thực thi trên những kiểu dữ liệu được định nghĩa 

trên Web server. 

Người sử dụng Web server không nhất thiết là client sử dụng Browser, 

có thể là ứng dụng console hoặc Windows Form. Trong mỗi trường hợp, client 

tương tác gián tiếp với Web server thông qua một proxy trung gian, proxy được 

xem là một kiểu dữ liệu nằm ở xa. Tuy nhiên, đoạn mã của proxy có nhiệm vụ 

chuyển những yêu cầu cho web server sử dụng HTTP chuẩn hoặc tùy chọn các 

thông điệp SOAP. 

1.2. Tầm quan trọng của web server  

Việc lựa chọn giải pháp tốt nhất cho web server là cần thiết và có ảnh 

hưởng tới việc phát triển các ứng dụng nghiệp vụ sau này. Web server có tầm 
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quan trọng đặc biệt trong toàn bộ môi trường hoạt động của xí nghiệp. 

Web server cho phép chuyển giao dữ liệu bao gồm văn bản, đồ họa và 

thậm chí cả âm thanh, video tới người sử dụng. Người sử dụng chỉ cần chạy 

trình duyệt web (Web Browser) để liên kết các máy chủ qua mạng IP nội bộ. 

yêu cầu của người sử dụng được đáp ứng bằng cách click chuột vào các chủ đề 

minh họa mẫu theo yêu cầu sẽ được gọi xuống từ máy chủ nào đó theo giao thức 

HTTP rồi hiển thị trên máy cá nhân. 

Các thành phần chủ chốt của web server là phần mềm. Mỗi Web 

server chạy trên một nền tảng phần cứng và một hệ điều hành cụ thể. Nhưng 

việc tạo các web server phục vụ cho hoạt động nghiệp vụ là vấn đề không dễ 

dàng. Ngoài việc lựa chọn ra một web server thích hợp và mạnh, người quản lý 

còn phải chú ý đến thiết kế mạng vì một web server thiết kế không tốt có thể dẫn 

đến giảm hiệu năng mạng. 

1.3. Các tiêu chuẩn đánh giá  

Nói về chức năng và hiệu năng, các web server phân bố thành bốn 

nhóm chính: các máy chủ truyền thông thường, máy chủ thương mại, máy chủ 

nhóm làm việc và máy chủ dùng cho mục đích đặc biệt. Các tiêu chuẩn đánh giá 

web server như sau: 

1.3.1. Hiệu năng 

Đây là thước đo sơ bộ nhằm trả lời câu hỏi web server làm việc như 

thế nào, các yếu tố ảnh hưởng đến hiệu năng bao gồm hệ điều hành và khả năng 

xử lý. 

1.3.2. Bảo mật 

Hầu hết các sản phẩm đều có cơ cấu điều khiển nhằm hạn chế truy cập 

của khách hàng tới kho thông tin chung chứa dữ liệu mật bằng các phương pháp 

như địa chỉ IP, tên máy chủ, mạng con và thư mục. Đặc biệt, web server của 

Oracle cung cấp phương án bảo mật theo tên người dùng và khóa mã được mã 

hóa hoàn toàn trong quá trình truyền trên mạng, tránh các truy cập bất hợp pháp. 

Một vài sản phẩm đưa ra các máy chủ ủy quyền (proxy server) để tạo bức tường 

lửa ngăn chặn việc xâm phạm không được phép truy cập từ bên ngoài. 

1.3.3. Truy cập và tích hợp với cơ sở dữ liệu 

Hầu hết các web server đều sử dụng giao diện CGI (Common 

Gateway Interface). Một số khác thì dùng giao diện lập trình ứng dụng (API), 

liên kết với cơ sở dữ liệu mở hoặc ngôn ngữ hỏi đáp có cấu trúc SQL. 

1.3.4. Quản lý và quản trị web server 

Đặc tính quan trọng của tiêu chuẩn này là khả năng quản trị từ xa, 

giao diện đồ họa và điều khiển cấu hình máy chủ. Các máy chủ truyền thông 

thường được xây dựng để truyền thông tin trên mạng công cộng và thường mang 

cả bốn tiêu chuẩn nhưng thiếu khả năng hỗ trợ bảo mật. Các máy chủ thương 
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mại có đặc tính này sẽ thuận lợi cho sữ lý ứng dụng nghiệp vụ có liên quan đến 

các vấn đề như giao dịch thẻ ứng dụng. Máy chủ nhóm làm việc, mạng IP nội bộ 

hay intranet, các máy chủ này sử dụng firewall nhằm bảo mật và ngăn chặn truy 

cập bất hợp pháp. 

1.4. Nền tảng cơ bản của web server  

Một vấn đề quan trọng cần phải cân nhắc trước tiên là vợi hệ điều 

hành nào sẽ chạy web server. Web server xuất phát từ Unix, môi trường đã được 

hoàn thiện qua thử thách. Bởi vậy, một công ty thông thường sẽ chọn Unix nếu 

muốn đảm bảo chắc chắn. Ngoài ra, quan trọng hơn, khả năng hỗ trợ nhiều bộ 

xử lý và liên kết lại là lĩnh vực ưu thế của Unix trước Windows NT. 

Hiện tại, có thể nói là tính năng của các web server không hơn kém 

bao nhiêu và các nhà quản lý thường muốn sử dụng những công cụ điều hành 

mà các nhà sản xuất cung cấp cho các hệ điều hành đó. Bởi vậy, theo nhận xét 

thì môi trường Unix có những công cụ quản lý tinh vi hơn. 

Tuy nhiên, Windows NT được đánh giá là hệ điều hành nhiều triển 

vọng, dễ cài đặt, sử dụng và hơn nữa chi phí cho một hệ Intel chạy Windows NT 

sẽ rẽ hơn một phần ba so với Unix, và đây có thể là ưu thế lớn nhất của 

Windows NT. Microsoft và Novell đều đang cố gắng đẩy mạnh hệ điều hành 

mạng của họ, mở rộng chức năng cho web server, bổ sung công cụ quản lý mà 

lâu nay khách hàng than phiền vì sự thiếu vắng của nó. Ngoài ra, cả hai cũng 

đang thực hiện việc kết nối hệ thống sever với các hệ thống email của người 

quản lý. 

1.4.1. Xử lý truy nhập cạnh tranh 

Web server thường phải xử lý một số lượng lớn yêu cầu giao dịch mỗi 

ngày. Để giải quyết vấn đề này, hầu hết các máy chủ thương mại đều chạy các 

hệ điều hành đa nhiệm như Unix Solaris, SCO, NFS, Windows NT và OS/2. 

Mặt khác, hiệu năng còn phụ thuộc vào chính các web server trong 

việc xử lý đa luồng. Với web server đa luồng, một tiến trình được tách thành 

nhiều tiến trình con (hay các luồng). Các luồng có thể được thực hiện đồng thời 

trên các tài nguyên khác nhau rồi sau đó có thể ghép lại để hoàn thiện quá trình. 

Các web server không hỗ trợ đa luồng thường là các sản phẩm miễn phí, cần 

phải khởi động tiến trình mới mỗi khi người sử dụng gởi yêu cầu tới. Một số ít 

sản phẩm như Oracle web server cung cấp khả năng đa luồng. Điểm khác biệt 

chính là, với đa luồng, hệ điều hành kiểm soát các luồng khác nhau, còn với giả 

đa luồng tiến trình nó tự kiểm soát các luồng và cấp phát tài nguyên cần thiết 

cho chúng. Kỹ thuật giả đa luồng mang lại hiệu năng tốt hơn nhiều so với đa 

luồng. 

1.4.2. Bảo mật 

Web server thương mại điều có cùng một dạng điều khiển truy nhập 
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chống xâm phạm. Một số web server cung cấp hàng loạt các lựa chọn điều khiển 

truy nhập cho người quản trị như địa chỉ IP, tên máy khách, tập tin, thư mục, tên 

người dùng và nhóm người dùng. Cơ cấu bảo mật có thể nằm trong web server 

hoặc trong hệ điều hành hay các thành phần liên kết. 

Các web server xử lý thông tin mật giống như trong các ứng dụng 

thương mại điện tử cần thiết bảo mật giao tác. Với tính năng này, truyền thông 

trên mạng giữa khách hàng và máy chủ được mã hóa. 

Giao thức được sử dụng cho bảo mật gồm Secure Sockets Layer 

(SSL) và Secure HTTP (SHTTP). Giao thức được sử dụng nhiều nhất là SSL, 

mã hóa toàn bộ phiên giao tác khách hàng/chủ. SHTTP là loại hướng tập tin. 

Thay vì mã hóa toàn bộ giao tác, giao thức này mã hóa các văn bản Web, sử 

dụng cho cả máy khách và máy chủ. Tuy nhiên, việc mã hóa dữ liệu phải dựa 

trên sự nhất quán về thuật toán giữa máy chủ và máy khách. 

1.4.3. Lưu trữ và truy nhập cơ sở dữ liệu 

Một lĩnh vực mà các nhà cung cấp web server đang bắt đầu khai phá 

là các giao thức dữ liệu, văn bản web lưu trữ và truy nhập như thế nào. Phương 

pháp thông thường nhất là dữ liệu được lưu dưới dạng các tập tin riêng rẽ trên 

các máy chủ khác nhau. Tuy vậy, một vấn đề sẽ xuất hiện đối với các web server 

lớn bởi vì một số lớn tập tin tăng lên không ngừng làm cho máy chủ ngày càng 

khó khăn trong việc kết xuất dữ liệu. 

1.4.4. Lựa chọn cuối cùng 

Việc lập kế hoạch web server không kết thúc ở lựa chọn sản phẩm. 

Người quản trị mạng cần phải lưu tâm đến vấn đề trước khi cài đặt và cấu hình 

web server. Các vấn đề đó liên quan đến thiết kế mạng, độ tin cậy của máy và 

giá cả. 

Trước khi đưa vào sử dụng web server, người quản trị mạng cần đảm 

bảo kiến trúc hạ tầng cho việc xử lý giao dịch về web, chẳng hạn như dự tính 

lưu lượng yêu cầu tới, kích thước đường truyền, vị trí các bộ router và cấu hình 

của mạng nội bộ. 

Một vấn đề khó nhận ra nữa là các web server cần thiết phải có khả 

năng xử lý hoặc chịu các lỗi và tính dư thừa hay phân đoạn sản phẩm. 

Một cách để đảm bảo độ tin cậy máy chủ là sử dụng kỹ thuật gọi là 

DNS (Domain Name Server) trong đó có một máy chủ là ánh xạ dữ liệu của một 

máy chủ có địa chỉ IP khác. Nhưng cái khó là làm thế nào để đảm bảo tại mọi 

lúc hai máy chủ đều giống nhau. 

Hầu hết các sản phẩm web server đều có giá vài nghìn đôla. Nhưng 

thực tế việc này còn liên quan đến giá phát triển, bảo trì và điều hành hệ thống, 

nghĩa là, khả năng phát triển của nhà cung cấp web server, đội ngũ bảo trợ tại 

địa phương cũng như việc huấn luyện đào tạo có chất lượng. 
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3. Mô hình hệ thống Web 

Mục tiêu: Giới thiệu cho người học các thành phần cấu thành một hệ 

thống Web cũng như các chức năng cơ bản của các thành phần này 

 
Hình 1.1: Mô hình Web nói chung 

Mạng dịch vụ Web là mạng các máy tính liên quan đến dịch vụ Web 

bao gồm các máy chủ dịch vụ, các máy tính và thiết bị phục vụ cho việc 

cung cấp dịch vụ Web. Hệ thống đó bao gồm: 

- Đường kết nối với mạng cung cấp dịch vụ Internet. 

- Các máy chủ cung cấp dịch vụ Web: cung cấp các dịch vụ web hosting, 

chứa các phần mềm Application Server đảm bảo việc phát triển các dịch vụ 

trên web, kết nối đến các cơ sở dữ liệu trên các máy tính khác, mạng khác. 

- Các máy chủ cơ sở dữ liệu, máy chủ chứng thực, máy chủ tìm kiếm ... 

- Hệ thống tường lửa (cả phần cứng và phần mềm) đảm bảo an toàn cho hệ 

thống máy chủ với môi trường Internet. 

- Hệ thống máy trạm điều hành, cập nhật thông tin cho máy chủ Web... 

3. Nguyên tắc hoạt động 

Mục tiêu: Hiểu được nguyên tắt hoạt động của một hệ thống Web nói chung 
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Hình 1.2: Sơ đồ hoạt động của WebServer 

Khi máy client kết nối vào Internet (thông qua hệ thống mạng LAN 

hay các đường dial up..), người sử dụng dùng trình duyệt web (web browser) 

gõ địa chỉ tên miền cần truy nhập (ví dụ: http://home.vnn.vn) gửi yêu cầu đến 

máy chủ Web. 

Web Server xem xét và thực hiện hết những yêu cầu từ phía Web 

browser gửi đến. Kết quả là một trang "thuần HTML" được đưa ra Browser. 

Người sử dụng sẽ hoàn toàn trong suốt với những gì đằng sau của một 

Web server như CGI Script, các ứng dụng cơ sở dữ liệu. 

Trường hợp là web tĩnh thì web server sẽ lấy thông tin lưu sẵn trên 

máy chủ dạng thư mục, file gửi lại theo yêu cầu của client. Trường hợp 

web động (dùng các ngôn ngữ lập trình web như ASP, PHP, JSP, CGI ... 

kết nối và khai thác cơ sở dữ liệu. 

Một ví dụ: Khi có kế hoạch đi công tác tại Hà nội, A biết có thể tìm 

được các thông tin liên quan tới thời tiết ở Hà nội tại địa chỉ Web 

"http://hanoi.vnn.vn" – địa chỉ này chính là một URI (Uniform Resource 

Identifier - world wide web address) . 

Khi A nhập URL trên vào trình duyệt thì: 

1. Trình duyệt sẽ thực hiện gửi yêu cầu lấy thông tin tới địa chỉ xác 

định trong URL thông qua giao thức truyền dữ liệu có tên là http. 

2. Máy chủ nới chứa thông tin sẽ xác định những thông tin cần thiết theo yêu 

cầu dựa trên URI của người sử dụng gửi tới. Truyền thông tin liên quan tới 

yêu cầu tới người sử dụng thông qua giao thức truyền thông http. 

3. Trình duyệt sau khi nhận được kết quả trả lời của máy chủ sẽ tiến hành 

trình bày dữ liệu kết quả  nhận  được  theo  khuôn  dạng  nhất  định.  Bản 

http://hanoi.vnn.vn/
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thân trong kết quả nhận được cũng bao gồm các liên kết tới thông tin ở vị 

trí khác trên Web và các vị trí này cũng được xác định bởi các URI. 

Trong ví dụ trên đã giới thiệu cho chúng ta ba cấu trúc của Web gồm: Xác 

định vị trí thông tin, Trao đổi và cách thể hiện thông tin: 

+ Xác định vị trí thông tin: Mỗi resource trong Web sẽ được xác định bởi 

Uniform Resource Identifier (URI). Trong ví dụ trên, resource dùng để lấy 

tông tin về thời tiết ở Hà nội được xác  định  bời  URI: "http://hanoi.vnn.vn". 

+ Trao đổi thông tin: Các tác nhân của Web (trình duyệt – browser, web 

server, …) thực hiện trao đổi thông tin thông qua các message, các message 

này được hình thành khi có yêu cầu của người sử dụng hoặc khi thực hiện 

các tiến trình xử lý dữ liệu. Các giao thức (Protocols) sẽ định nghĩa cách 

thức trao đổi dữ liệu giữa các tác nhân trong Web, trong ví dụ này là giao 

thức HTTP. 

Thể hiện thông tin: Các message được hình thành khi trao đối thông 

tin giữa các tác nhân trong web đã chứa các định dạng dữ liệu. Tùy thuộc vào 

từng yêu cầu cụ thể mà các đinh dạng thể hiện dữ liệu sẽ khác nhau. Trong 

trường hợp khi nhận kết quả trả lời từ các web server, các định dạng đó 

có thể là: HTML, XML, … dữ liệu ảnh, … Dựa trên các định dạng được 

định nghĩa này, trình duyệt sẽ trình bày lại sao cho dữ liệu có thể giúp người 

sử dụng khai thác thông tin một cách dễ dàng. 

Câu hỏi 

Câu 1: Trình bày các thành phần của một hệ thống Web 

Câu 2:  Trình bày nguyên tắc hoạt động của hệ thống Web 

http://hanoi.vnn.vn/
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BÀI 2: QUẢN TRỊ MÁY CHỦ WEB SERVER 

Mã bài: 19.2 

 

Mục tiêu: 

- Trình bày nguyên tắc hoạt động Web Server; 

- Cài đặt và cấu hình được Web Server trên Windows Server; 

- Quản trị được Web Server; 

- Cài đặt các công cụ bảo mật cho Web Server; 

- Sao lưu và phục hồi Web site. 

- Thực hiện các thao tác an toàn với máy tính. 

Nội dung chính: 

1. Giao thức HTTP 

HTTP là một giao thức cho phép Web Browser và Web Server có 

thể giao tiếp với nhau. HTTP bắt đầu là 1 giao thức đơn giản giống như 

với các giao thức chuẩn khác trên Internet, thông tin điều khiển được 

truyền dưới dạng văn bản thô thông qua kết nối TCP. Do đó, kết nối 

HTTP có thể thay thế bằng cách dùng lệnh telnet chuẩn. 

Ví dụ: 

> telnet www.extropia 80 GET /index.html HTTP/1.0 

<- Có thể cần thêm ký tự xuống dòng 

Để đáp  ứng lệnh HTTP GET , Web server trả về cho Client 

trang "index.html" thông qua phiên làm việc telnet này, và sau đó đóng kết 

nối chỉ ra kết thúc tài liệu. 

Thông tin gởi trả về dưới dạng: 

<HTML> 

<HEAD> 

<TITLE>eXtropia Homepage</TITLE> [...] 

</HEAD> 

</HTML> 

Giao thức đơn giản yêu-cầu/đáp-ứng (request/response) này đã 

phát triển nhanh chóng và được định nghĩa lại thành một giao thức phức tạp 

(phiên bản hiện tại HTTP/1.1) . Một trong các thay đổi lớn nhất trong 

HTTP/1.1 là nó hỗ trợ kết nối lâu dài (persistent connection). 

Trong HTTP/1.0, một kết nối phải được thiết lập  đến  Server  cho 

mỗi đối tượng mà Browser muốn download. Nhiều trang Web có rất nhiều 

hình ảnh, ngoài việc tải trang HTML cơ bản, Browser phải lấy về một 

số lượng hình ảnh. Nhiều cái trong chúng thường là nhỏ hoặc chỉ đơn 

thuần là để trang trí cho phần còn lại của trang HTML. 

2. Nguyên tắc hoạt động của Web Server 
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Ban đầu Web Server chỉ phục vụ các tài liệu HTML và hình ảnh đơn 

giản. Tuy nhiên, đến thời điểm hiện tại nó  có thể làm nhiều hơn thế. 

Đầu tiên xét Web Server ở mức độ cơ bản, nó chỉ phục vụ các 

nội dung tĩnh. Nghĩa là khi Web Server nhận 1 yêu cầu từWeb Browser,  nó  

sẽ ánh xạ đường dẫn này URL (ví dụ: 

http://www.brtvc.edu.vn/index.html) thành một tập tin cục bộ trên máy Web 

Server. 

Máy chủ sau đó sẽ nạp tập tin này từ đĩa và gởi tập tin đó qua 

mạng đến Web Browser của người dùng. Web Browser và Web Server 

sử dụng giao thức HTTP trong quá trình trao đổi dữ liệu. 

 

 
 

Hình 2.1: Sơ đồ hoạt động của Web Server. 

Trên cơ sở phục vụ những trang Web tĩnh đơn giản này, ngày 

nay chúng đã phát triển với nhiều thông tin phức tạp hơn được chuyển giữa 

Web Server và Web Browser, trong đó quan trọng nhất có lẽ là nội 

dung động (dynamic content). 

2.1. Cơ chế nhận kết nối 

Với phiên bản đầu tiên, Web Server hoạt động theo mô hình sau: 

- Tiếp nhận các yêu cầu từ Web Browser. 

- Trích nội dung từ đĩa . 

- Chạy các chương trình CGI. 

- Truyền dữ liệu ngược lại cho Client. 

Tuy nhiên, cách hoạt động của mô hình trên không hoàn toàn 

tương thích lẫn nhau. 

Ví dụ, một Web Server đơn giản phải theo các luật logic sau: 

- Chấp nhận kết nối. 

- Sinh ra các nội dung tĩnh hoặc động cho Browser. 

- Đóng kết nối. 

- Chấp nhận kết nối. 

- Lập lại quá trình trên ... 

http://www.brtvc.edu.vn/index.html)
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Điều này sẽ chạy tốt đối với các Web Sites đơn giản, nhưng Server 

sẽ bắt đầu gặp phải vấn đề khi có nhiều người truy cập hoặc có quá nhiều 

trang Web động phải tốn thời gian để tính toán cho ra kết quả. 

Ví dụ: Nếu một chương trình CGI tốn 30 giây để sinh ra nội dung, trong 

thời gian này Web Server có thể sẽ không phục vụ các trang khác nữa . 

Do vậy, mặc  dù mô  hình  này hoạt động được, nhưng nó vẫn  cần 

phải thiết kế lại để phục vụ được nhiều người trong cùng 1 lúc. Web 

Server có xu hướng tận dụng ưu điểm của 2 phương pháp khác nhau để 

giải quyết vấn đề này là: đa tiểu trình (multi-threading) hoặc đa tiến  trình 

(multi- processing) hoặc các hệ lai giữa multi-processing và multi-threading. 

2.2. Web Client 

Là những  chương  trình  duyệt  Web  ở  phía  người  dùng,  như 

Internet Explorer, Netscape Communicator.., để hiển thị những thông tin 

trang Web cho người dùng. Web Client sẽ gửi yêu cầu đến Web Server. 

Sau đó, đợi Web Server xử lý trả kết quả về cho Web Client hiển thị 

cho người dùng. Tất cả mọi yêu cầu đều được xử lý bởi Web Server. 

2.3. Web động 

Một trong các nội dung động (thường gọi tắt là Web động) cơ bản 

là các trang Web được tạo ra để đáp ứng các dữ liệu nhập vào của người 

dùng trực tiếp hay gián tiếp. 

Cách cổ điển nhất và được dùng phổ  biến  nhất  cho  việc  tạo  nội 

dung động là sử dụng Common Gateway Interface (CGI). Cụ thể là CGI 

định nghĩa cách thức Web Server chạy một chương trình cục bộ, sau đó 

nhận kết quả và trả về cho Web Browser của người dùng đã gửi yêu cầu. 

Web Browser thực sự không biết nội dung của thông tin là động, 

bởi vì CGI về cơ bản là một giao thức mở rộng của Web Server. Hình 

vẽ sau minh hoạ khi Web Browser yêu cầu một trang Web động phát 

sinh từ một chương trình CGI. 

 

 
Hình 2.2 Mô hình Xử lý. 

Một giao thức mở rộng nữa của HTTP là HTTPS cung cấp cơ 

chế bảo mật thông tin ―nhạy cảm‖ khi chuyển chúng xuyên qua mạng. 
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3. Đặc điểm của IIS (Internet Information Services) 

IIS 7.0 có sẳn trên tất cả các phiên của Windows 2008, IIS cung cấp 

một số đặc điểm mới giúp tăng tính năng tin cậy, tính năng quản  lý,  tính 

năng bảo mật,   tính năng mở rộng và tương thích với hệ thống mới. IIS 7.0 

là phiên bản mới nhất cho web server của Microsoft. IIS có trong Windows 

Server từ khi Windows 2000 Server với tư cách là một thành phần của 

Windows và từ Windows NT thì là một tùy chọn. IIS 7.0 hiện được cung cấp 

trong Windows Vista và Windows Server 2008, hệ điều hành máy chủ được 

dự định sẽ phát hành vào đầu năm 2008. IIS 7.0 là một phiên bản được xem 

xét một cách tỉ mỉ trong thiết kế từ kinh nghiệm của các phiên bản trước. 

Phiên bản 7.0 ra đời tạo một nền tảng linh hoạt và an toàn nhất cho việc cấu 

hình web và các ứng dụng.  

IIS 7.0 được thiết kế để trở thành một nền tảng Web và ứng dụng linh 

động và an toàn nhất cho Microsoft. Microsoft đã thiết kế lại IIS từ những 

nền tảng đã có trước đó và trong suốt quá trình phát triển, nhóm thiết kế IIS 

đã tập trung vào 5 lĩnh vực lớn: 

 Bảo mật 

 Khả năng mở rộng 

 Cấu hình và triển khai 

 Quản trị và chuẩn đoán 

 Hiệu suất 

3.1.Những điểm mới ở IIS 7.0  

Hầu hết mọi thứ trong IIS 7.0 đều là mới. Microsoft đã tập trung vào việc 

modul hóa khi xây dựng IIS 7.0, điều đó đã giảm thiểu được bề mặt tấn công 

của web server.  

Một ví dụ cho vấn đề này: Nếu bạn cần một FTP Server hoặc tính năng 

Cache trong IIS thì phải cài đặt các FTP Server hoặc Cache để quản lý và kích 

hoạt hành động lưu trữ (cache) hoặc FTP Server. 

Windows Server 2008 sẽ gồm có tất cả các tính năng cần thiết của IIS hỗ 

trợ cho việc cấu hình Web trong các môi trường sản xuất. Windows Vista chỉ 

có một số tính năng của IIS và các tính năng này phụ thuộc vào phiên bản 

Windows Vista. IIS 7.0 trong Windows Vista là một cách xử lý cho việc xây 

dựng và kiểm tra các ứng dụng web của bạn. Các modul được bổ sung và tính 

năng thêm vào sẽ được cung cấp từ Microsoft hoặc bạn có thể tự viết mã, 

thậm chí có thể mua từ một hãng phần mềm thứ ba nào đó.  

3.2. Kiến trúc  

Bên cạnh những thay đổi đối với các thành phần lõi trong IIS 7.0, sự tập 

trung với các thiết kế modul luôn luôn được thực hiện trong sản phẩm này. 
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Thiết kế modul làm cho IIS 7.0 linh động hơn và bảo mật tốt hơn so với các 

phiên bản IIS trước đây. 

 
Hình 2.3 : Tổng quan về các modul chính và thành phần của IIS 7.0 

Ưu điểm chính của thiết kế modul mới là sẽ giảm được dấu vết, điều làm 

cho nền tảng web server được an toàn hơn khi tấn bề mặt tấn công được giảm 

thiểu.  

IIS 7.0 cung cấp một API mới, thay thế cho bộ lọc ISAPI trong các phiên bản 

trước. Với API mới này, IIS 7.0 hiện có thể mở rộng bằng các modul mở rộng 

hoặc thậm chí thay thế bất kỳ modul đính kèm bằng các modul được viết.  

Các modul mới có thể được download từ website IIS.net của 

Microsoft:http://www.iis.net/downloads  

3.3. Quản trị  

Có một số phương pháp được thiết kế cho việc quản trị của IIS 7.0 

 GUI sử dụng IIS Manager 

 Công cụ lệnh APPCMD 

 Quản trị từ xa bằng IIS Manager 

 Viết kịch bản (Script) bằng Windows PowerShell 

 Giao diện Microsoft.Web.Administration API 

Giao diện quản trị GUI cũng được thiết kế lại, IIS Manager mới hiện là một giao 

diện quản lý dựa trên hành động và hướng nhiệm vụ hơn, được biết đến từ ISA 

Server và Exchange Server 2007 mới. 

http://www.iis.net/downloads
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Hình 2.4 : Màn hình của IIS Manager 

IIS Manager có thể được sử dụng để cấu hình IIS và các thiết lập 

ASP.NET, các thiết lập cấu hình sẽ được viết thành file cấu hình xml. Một thành 

phần mới, Health and diagnostics information có thể được cung cấp và chạy như 

các công cụ tích hợp trực tiếp từ bên trong IIS Manager và là một phần của IIS 

7.0.  

APPCMD là một công cụ nhắc lệnh nhiều mục đích cho IIS 7.0, công cụ 

này có thể được sử dụng cho việc cấu hình và quản trị của IIS. APPCMD là một 

phiên bản nâng cao của adsutil.vbs cũ, bạn hoàn toàn có thể thấy quen thuộc với 

công cụ này vì chúng đã có trong IIS 6.0. Vấn đề quản trị từ xa cũng được nâng 

cao và hiện có thể sử dụng bằng IIS Manager, việc truyền thông được đảm bảo 

an toàn hơn bằng https đến web server.  

Cũng có tùy chọn của việc tạo kịch bản về quản lý IIS. Vấn đề này được 

thực hiện bằng sử dụng Windows PowerShell, đây là một ngôn ngữ viết kịch 

bản mới của Microsoft. Nó cho phép bạn dễ dàng và hiệu quả trong việc quản lý 

IIS trên web server và đây thực sự là một điều hữu dụng nếu phải quản lý một số 

web server hoặc một hệ thống web lớn. Windows PowerShell có thể được sử 

dụng trực tiếp với giao diện WMI của IIS hoặc sử dụng để đọc và ghi trong các 

file cấu hình XML của IIS 7.0.  

IIS 7.0 có khả năng tương thích với cơ sở dữ liệu IIS 6.0 và giao diện kịch 

bản WMI và ADSI, điều đó có nghĩa là tất cả các kịch bản cũ cho IIS 6.0 sẽ vẫn 

làm việc trên IIS 7.0.  
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Microsoft.Web.Administration API là một giao diện được nhắm đến cho 

các chuyên gia phát triển phần mềm, những người muốn viết mã chương trình 

của họ hoặc các kịch bản để quản lý IIS 7.0.  

Trong IIS 7.0, bạn có thể ủy nhiệm việc quản lý cho IIS và các website. 

Bạn có thể ủy nhiệm toàn bộ truy cập quản trị vào chính site thuộc quyền sở hữu 

của bạn trong một website. Site thuộc quyền sở hữu của bạn sau đó có thể kiểm 

soát và quản lý tất cả các thiết lập website bằng IIS Manager mà không cần đến 

việc thỏa hiệp bảo mật máy chủ. Tất cả các thiết lập mà site bạn có quyền sở 

hữu quản lý được ghi vào file web.config của chính website.  

3.4. Cấu hình  

Cấu hình được thực hiện đơn giản và dựa trên các file XML đã phân phối 

để giữ thiết lập cấu hình cho toàn bộ IIS và ASP.NET.  

Các thiết lập cấu hình có thể được thực hiện cho toàn bộ web server hoặc 

cho một số website nào đó bằng sử dụng các file XML hoặc thông quan giao 

diện quản lý GUI. GUI chỉ ghi các thiết lập cấu hình vào các file XML giống 

nhau. Các file cấu hình xml chính trong IIS 7.0 là: 

 Applicationhost.config 

 Global web.config 

 Machine.config 

 Site web.config 

 App web.config 

Bằng cách sử dụng các file cấu hình cơ sở, sự triển khai và nâng cấp trong 

các môi trường web lớn được tối ưu hóa. Nó cũng cho phép bạn dễ dàng sao 

chép cấu hình IIS đến một máy chủ mới.  

Quá trình tái tạo cấu hình web server cũng được thực hiện dễ dàng với IIS 

7.0 bởi chúng dựa vào các file cấu hình xml. Điều này làm cho nó trở nên dễ 

dàng trong việc tái tạo và triển khai cấu hình trong các môi trường ―nông trang‖ 

lớn hơn.  

Shared Configuration là một tính năng mới trong IIS 7.0, cấu hình này 

được thiết kế cho các kịch bản hệ thống web. Với Shared Configuration bạn 

hoàn toàn có thể chia sẻ nhiều web server với một file cấu hình 

(applicationhost.config). Điều khiển của file cấu hình applicationhost.config sẽ 

được định vị trên một đường dẫn UNC chung. Tính năng cấu hình chia sẻ là một 

cải thiện tuyệt vời trong các thiết lập của IIS.  

File xml Applicationhost.config là file cấu hình chính của IIS 7.0, file cấu 

hình này gồm có tất cả các thông tin về site, thư mục ảo, các ứng dụng và thiết 

lập chung cho web server.  
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Việc tái tạo nội dung có thể được thực hiện một cách dễ dàng bằng các lệnh 

đơn giản x-copy hoặc robocopy cũng như các cấu hình website cụ thể được lưu 

trong file xml web.config bên trong mỗi website. 

3.5. Kết luận  

Với những thiết kế mới của IIS, Microsoft thực sự đã tập trung vào việc tạo 

cho IIS 7.0 trở thành một web server tốt hơn đối với bất kỳ ai, từ các chuyên gia 

CNTT, chuyên gia phát triển phần mềm đến các Web Hoster. Để tổng kết lại 

chúng tôi đã đưa ra một số lý do chính cho tại sao người ta sẽ tin tưởng vào IIS 

7.0 là một sản phẩm mạnh: 

 Bảo mật tốt hơn 

 Khả năng mở rộng và linh động bằng kiến trúc modul mới. 

 Dễ dàng trong nâng cấp vì tính đơn giản trong cấu hình, dựa trên các file 

xml. 

 Hiệu suất tốt hơn nhờ có những cải thiện trong phần lõi của IIS (http.sys) 

Có rất nhiều cách để có thể dùng thử IIS 7.0 và để chính bạn tự cảm thấy 

quen sử dụng hơn trước khi có bản chính thức được phát hành.  

Bạn có thể download IIS 7.0 cùng với phiên bản mới nhất của Windows 

Server 2008 tại http://www.microsoft.com/windowsserver2008/default.mspx.  

4. Cài đặt và cấu hình WEB Server  

4.1. Cài đặt Web Server (IIS) role 

Mở Server Manager từ Administrative tools. Trên cửa sổ Server 

Manager, chọn Role sau đó chọnAdd Roles để cài đặt Web Server (IIS) role. 

Trên cửa sổ Before You Begin chọn Next để tiếp tục 

Trên cửa sổ Select Server Roles, đánh dấu chọn vào mục Web Server 

(IIS) 

Trên hộp thoại Add Roles Wizard chọn Add Required Features để bổ sung 

các dịch vụ đi kèm. 

 
Trên cửa sổ Select Server Roles chọn Next để tiếp tục 

http://www.microsoft.com/windowsserver2008/default.mspx


 

24 
 

 
Trêncửa sổ Web Server (IIS) chọn Next để tiếp tục 

Trên cửa sổ Select Role Services tick chọn IIS và chọn Next để tiếp tục 

 
trên cửa sổ Confirm Installation Selections chọn Install để tiến hành cài đặt 

Sau khi quá trình cài đặt xong, chọn Close để hoàn tất. 
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4.2. Khảo sát Default Web Site 

Mở Internet Information Services (IIS) Manager từ Administrative 

Tools 

Trên cửa sổ Internet Information Services (IIS) Manager, mở DC1, mở Site, 

chuột phải vàoDefault Web Site, chọn Manage Web Site sau đó 

chọn Advanced Setting… 
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Trên hộp thoại Advanced Settings, kiểm tra database của Default Web 

Site đang lưu trữ tại đường dẫn%SystemDriver%\Inetpub\wwwroot, 

chọn OK để tiếp tục. Mở Windows Explorer, vào C:\Inetpub\wwwroot kiểm 

tra database của Default Web Site gồm có 2 file mặc 

định iisstart.htm và welcome.png 

 
4.3. Tạo bản ghi cho domain 

Vào DNS Server (máy Dc1) tạo một bản ghi New Host A tên www trỏ về 

máy IP 192.168.3.1 web server là máy DC1. Nếu không biết cách tạo, mời xem 

lại bài  Cài đặt và cấu hình DNS trên windows 2008 

http://hoangthongit.com/windows/cai-dat-va-cau-hinh-dns-tren-windows-2008.html
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4.4. Cấu hình Web Server 

Sử dụng notepad tạo một file index.html với nội dung Welcome To 

HoangThongIT.com được đặt trong thư mục web nằm trong ổ C. Đây là file nội 

dung của trang web 

Mở Internet Information Service (IIS) Manager từ Administrative 

Tools. Mở DC1, sau đó chuột phải vào Site chọn Add Web Site… 

 
Trên hộp thoại Add Web Site nhập CaodangngheBRVT vào ô Site 

name trong ô Physical Path trỏ đường dẫn đến C:\ web, trong ô Type 

chọn http trong ô Host name nhập www.brtvc.edu.vn, sau đó chọnOK 

http://www.contoso.com/
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Trên cửa sổ Internet Information Service (IIS) Manager, 

chọn CaodangngheBRVT, trong cửa sỗ giữa chọn Default Document. Kích 

phải vào màn hình trống chọn Add -> nhập trang chủ website brtvc.htm -> 

Chọn file brtvc.htm chọn Move Up để đưa file brtvc.htm lên đứng đầu danh 

sách 
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Chuột phải vào trang web CaodangngheBRVT, tiếp theo chọn Manage Web 

Site, chọn Restart để khởi động lại trang web này. 

Để kiểm tra kết quả cấu hình web server, mở Internet Exprorer, truy cập 

vào địa chỉhttp://www.brtvc.edu.vn, chúng ta sẽ thấy kết quả trang web sẽ hiển 

thị đúng nội dung trang web. 

 
4.5. Cấu hình Virtual Directory 

Vào C:\Web tạo thư mục tên News sau đó tạo file index.htm có nội dung 

tùy ý. Ví dụ ở đây là: Welcome to Brtvc.edu.vn 

Mở Internet Information Service (IIS) Manager từ Administrative 

Tools. Mở DC1 à Site, sau đó chuột phải vào CaodangngheBRVT và 

chọn Add Virtual Directory… 

 
Trên hộp thoại Add Virtual Directory, nhập news vào ô Alias. Trong 

ô Physical path trỏ đường dẫn đến C:\ CaodangngheBRVT \News, sau đó 

chọn OK. Kiểm tra trong CaodangngheBRVT đã có Virtual Directory tên 

là News 

http://www.hoangthongit.com/
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Mở Internet Explorer, truy cập vào địa chỉ 

http://www.brtvc.edu.vn/news, chúng ta sẽ thấy hiển thị chính xác thông tin về 

trang web. 

5. Hosting nhiều Web Site trên cùng máy chủ Web Server 

(thao tác tương tự phần 4.4) 

Ở trên chúng ta đã cấu hình cho một website hoa brtvc.edu.vn, bây giờ chúng 

ta muốn tạo một thêm website khác cho tên miền khoacntt.com . Các bước thực 

hiện như sau: 

Thực hiện trên máy DNS 

Mở DNS Manager từ Administrative Tools. Tiếp theo tạo Forward 

Lookup Zones cho tên miền khoacntt.com trong zone khoacntt.com tạo bản 

ghi New Host A trỏ tới tới địa chỉ web server là192.168.3.2 (Nếu không biết 

cách tạo, mời xem lại bài  Cài đặt và cấu hình DNS trên windows 2008) 

Thực hiện trên máy DC1 

Tạo thư mục C:\Khoacntt, và tạo file khoacntt.htm có nội dung bất kỳ. Ví dụ ở 

đây là: Welcome to khoa CNTT truong Cao dang nghe 

Mở Internet Information Service (IIS) Manager từ Administrative 

Tools. Mở DC1, sau đó chuột phải vào Site chọn Add Web Site… 

Trên màn hình Add Web Site nhập ThongHoangit vào ô Site name. 

Trong ô Physical Path trỏ đường dẫn đến C:\ khoaCNTT Trong 

ô Type chọn http. Trong ô Host name nhập www.khoacntt.com, sau đó 

chọn OK 

Tiếp theo chuột phải vào  website khoacntt chọn Manage Web Site, 

chọn Restart để khởi động lại trang web này. 

http://hoangthongit.com/windows/cai-dat-va-cau-hinh-dns-tren-windows-2008.html
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Mở Internet Explorer, truy cập địa chỉ www.khoacntt.com chúng ta sẽ 

thấy kết quả là truy cập thành công đến cả hai website này. 

Câu hỏi 

Câu 1: Trình bày nguyên tắc hoạt động của hệ thống Web Server 

Câu2: Trình bày các thành phần chính trong IIS (Internet Information 

Services) 

Câu 3: Nêu các thuộc tính cơ bản trong IIS 

Câu 3: Bài tập ứng dụng nâng cao: Tạo 1 Website đơn gản dưới đây, cấu hình 

và bảo mật 1 Webserver trên môi trường Domain Network 

Hướng dẫn thực hiện: 

1. Cài đặt và cấu hình DNS với tên miền www.cntt.edu 

2. Cài đặt dịch vụ IIS 

3. Cấu hình 1 Website 

4. Bảo mật Website 

5. Cấu 2 W hình 2 Website trên 1 Webserver 

http://www.khoacntt.com/
http://www.cntt.edu/
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BÀI 3. KHÁI NIỆM CHUNG VỀ HỆ THỐNG THƯ ĐIỆN TỬ 

Mã bài: 19.3 

 

Mục tiêu: 

- Trình bày được tổng quan về thư điện tử; 

- Trình bày được kiến trúc và hoạt động của thư điện tử; 

- Trình bày được cấu trúc của địa chỉ thư điện tử. 

- Thực hiện các thao tác an toàn với máy tính. 

Nội dung chính: 

1. Giới thiệu thư điện tử 

1.1. Thư điện tử là gì 

Thư điện tử còn được gọi tắt là E-Mail (Electronic Mail). E-Mail 

có nhiều cấu trúc khác nhau tùy thuộc vào hệ thống máy vi tính của 

người sử dụng. Mặc dù khác nhau về cấu trúc nhưng tất cả đều  có  một  

mục  đích chung là gửi hoặc nhận thư điện tử từ một nơi này đến một nơi 

khác nhanh chóng. Ngày nay, nhờ sự phát triển mạnh mẽ của Internet 

(Mạng Lưới Truyền Tin Toàn Cầu) người ta có thể gửi điện thư tới các quốc 

gia trên toàn thế giới. Với lợi ích như vậy nên thư điện tử hầu như trở 

thành một nhu cầu cần phải có của người sử dụng máy vi tính. Giả sử 

như bạn đang là một nhà kinh doanh nhỏ và cần phải bán hàng trên  toàn  

quốc.  Vậy  làm  thế  nào  mà  bạn có thể liên lạc với khách hàng một cách 

nhanh chóng và dễ dàng. Thư điện tử là cách giải quyết tốt nhất và nó đã 

trở thành một dịch vụ phổ biến trên Internet. 

Tại các nước tiên tiến cũng như các nước đang phát triển, các 

trường đại học, các cơ cấu thương mại, các cơ quan chính quyền v.v. đều đã 

và đang kết nối hệ thống máy vi tính của họ vào Internet để sự chuyển 

thư điện tử được nhanh chóng và dễ dàng. 

1.2. Lợi ích  của thư điện tử 

Thư điện tử có rất nhiều công dụng vì chuyển nhanh chóng và sử 

dụng dễ dàng. Mọi người có thể trao đổi ý kiến tài liệu với nhau trong 

thời gian ngắn. Thư điện tử ngày càng đóng một vai trò quan trọng trong 

đời sống, khoa học, kinh tế, xã hội, giáo dục, và an ninh quốc gia. Ngày 

nay, người ta trao đổi với nhau hằng ngày những ý kiến, tài liệu với nhau 

bằng điện thư mặc dù cách xa nhau hàng ngàn cây số. 

Vì thư điện tử phát triển dựa vào cấu trúc của Internet cho nên cùng 

với sự phát triển của Internet, thư điện tử  càng  ngày càng  phổ  biến  trên  

toàn thế giới. Người ta không ngừng tìm cách để khai thác đến mức tối đa 

về sự hữu dụng của nó. Thư điện tử phát triển được bổ sung  thêm các tính 

năng sau: 
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- Mỗi bức thư điện tử sẽ mang nhận dạng người gửi. Như vậy người nhận sẽ 

biết ai đã gửi thư cho mình một cách chính xác. 

- Người ta sẽ dùng thư điện tử để gửi thư viết bằng tay. Có nghĩa là 

người nhận sẽ đọc thư điện mà người gửi đã viết bằng tay. 

- Thay vì gửi lá thư điện bằng chữ, người gửi có thể dùng điện thư để gửi 

tiếng nói. Người nhận sẽ lắng nghe được giọng nói của người gửi  khi 

nhận được thư. 

- Người gửi có thể gửi một cuốn phim hoặc là những hình ảnh lưu động cho 

người nhận. 

Trên đây chỉ là vài thí dụ điển hình mà thư điện tử đang phát 

triển.Với trình độ khoa học kỹ thuật như hiện nay những việc trên sẽ thực 

hiện không mấy khó khăn. Những trở ngại lớn nhất hiện giờ là  đường 

chuyển tải  tín hiệu của Internet còn chậm cho nên không thể nào chuyển 

tải số lượng lớn của tín hiệu. Ngoài ra còn trở ngại khác như máy tính 

không đủ sức chứa hay xử lý hết tất cả tín hiệu mà nó nhận được. Nên 

biết rằng những âm thanh (voice) và hình ảnh (graphics) thường tạo ra 

những số lượng lớn thông tin. 

Gần đây người ta đã bắt đầu xây dựng những đường chuyển tải tốc 

độ cao cho Internet với lưu lượng nhanh gấp trăm lần so với đường cũ. Hy 

vọng rằng với đà tiến triển như vậy, mọi người trên Internet sẽ có thêm 

được nhiều lợi ích về việc sử dụng điện thư. 

2. Kiến trúc và hoạt động của hệ thống thư điện tử 

Muốn gửi thư điện tử người gửi cần phải có một tài khoản 

(account) trên một máy chủ thư. Một máy chủ có thể có một hoặc nhiều 

account. Mỗi account đều được mang một tên khác nhau (userID). Mỗi 

account đều có một hộp thư riêng (mailbox) cho account đó. Thông thường 

thì tên của hộp thư sẽ 

giống   như   tên   của   account. Ngoài  ra  máy 

vi tính đó phải được nối trực tiếp hoặc gián tiếp 

với hệ thống Internet nếu muốn gửi  nhận  thư 

điện tử toàn cầu. Người sử dụng máy vi tính tại 

nhà  vẫn  có  thể  gửi  nhận  thư điện   tử  bằng 

cách kết nối máy vi tính của họ với  một  máy 

vi tính bằng modem. Có một số nơi   cấp   phát 

account thư điện tử miễn phí cho các    máy    vi 

tính tại nhà có thể dùng modem để kết nối với 

máy vi tính đó để chuyển nhận thư điện tử như hotmail.com hoặc 

yahoo.com 

.v.v. Ngoài ra, còn có rất nhiều  cơ  quan  thương  mại  cung  cấp  dịch  vụ 
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hoặc account cho máy vi tính tại nhà nhưng người sử dụng phải trả tiền 

dịch vụ hàng tháng. 

Đường đi của  thư 

Mỗi một bức thư truyền thống phải đi tới các bưu cục khác nhau 

trên đường đến với người dùng. Tương tự thư điện  tử  cũng chuyển  từ  

máy máy chủ thư điện tử này (mail server) tới máy chủ tư điện tử khác 

trên internet. Khi  thư  được  chuyển  đến đích thì nó được chứa tại hộp 

thư điện tử tại máy chủ thư điện tử cho đến  khi  nó được  nhận  bởi  người  

nhận. Toàn bộ quá trình xử lý chỉ xảy ra trong vài phút, do đó nó cho phép 

nhanh chóng liên lạc với mọi người trên toàn thế  giới  một  cánh  nhanh 

chóng tại bất cứ thời điểm nào dù ngày hay đêm. 

Gửi, nhận và chuyển thư 

Để nhận được thư điện tử bạn cần phải có một tài khoản (account) 

thư điện tử. Nghĩa là bạn phải có một địa chỉ để nhận thư. Một  trong 

những thuận lợi hơn với thư thông thường là bạn có thể nhận thư điện tử 

từ bất cứ đâu. Bạn chỉ cần kết nối vào Server thư điện tử để lấy thư về 

máy tính của mình. 

Để gửi được thư bạn cần phải có một kết nối vào internet và truy 

nhập vào máy chủ thư điện tử để chuyển thư đi. Thủ tục tiêu chuẩn được 

sử dụng để gửi thư là SMTP (Simple Mail Transfer Protocol). Nó được 

kết hợp với thủ tục POP (Post Office Protocol) và IMAP (Internet 

Message Access Protocol) để lấy thư. 

Trên thực tế có rất nhiều hệ thống vi tính khác nhau và mỗi hệ thống 

lại có cấu trúc chuyển nhận thư điện tử khác nhau. Vì có sự khác biệt như 

vậy nên việc chuyển nhận thư điện tử giữa hai hệ thống khác nhau rất là 

khó khăn và bất tiện. Do vậy, người ta đã đặt ra một nghi thức chung cho 

thư điện tử. Có nghĩa là các hệ thống máy vi tính đều đồng ý với nhau về 

một nghi thức chung gọi là Simple Mail Transfer Protocol viết tắt là 

SMTP. Nhờ vào SMTP này mà sự chuyển vận thư từ điện tử trên 

Internet đã trở thành dễ dàng nhanh chóng cho tất cả các người sử dụng 

máy vi tính cho dù họ có sử dụng hệ thống máy vi tính khác nhau. 

Khi gửi  thư điện tử thì máy tính  của bạn cần phải  định hướng 

đến máy  chủ SMTP. Máy chủ sẽ tìm kiếm địa chỉ thư điện tử (tương tự 

như địa 

chỉ điền trên phong bì) sau đó chuyển tới máy chủ của người nhận và nó 

được chứa ở đó cho đến khi được lấy về. Bạn có thể gửi thư điện tử đến 

bất cứ ai trên thế giới mà có một địa chỉ thư điện tử. Hầu hết các nhà cung 

cấp dịch vụ Internet đều cung cấp thư điện tử cho người dùng internet. 

Chuyển thư (Send Mail) 
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Sau khi người sử dụng máy vi tính dùng chương trình thư để viết 

thư và đã ghi rõ địa chỉ của người  nhận  thì  máy  tính  sẽ  chuyển  bức  thư  

điện đến hộp thư người nhận. SMTP sử dụng nghi thức TCP (TCP 

protocol) để chuyển vận thư. 

Đôi khi vì máy vi tính của người nhận đã bị tắt điện hoặc đường dây 

kết nối từ máy gửi tới máy nhận đã bị hư hỏng tạm thời tại một nơi nào  đó 

(tranmission  wire  failure),  hoặc là  có  thể là Máy Chuyển Tiếp (routers) 

trên tuyến đường liên lạc giữa hai máy tạm thời bị hư (out of order) thì 

máy gửi không cách nào liên lạc với máy nhận được. Gặp trường hợp như 

vậy thì máy gửi sẽ tạm thời giữ lá thư trong khu vực dự trữ tạm thời. 

Máy gửi sau đó sẽ tìm cách liên lạc với máy nhận để chuyển thư. Những 

việc này xảy ra trong máy vi tính và người sử dụng sẽ không hay biết gì. 

Nếu trong khoảng thời gian mà máy vi tính của nơi gửi vẫn không liên lạc 

được với máy nhận thì máy gửi sẽ gửi một thông báo cho người gửi nói 

rằng việc vận chuyển của lá thư điện đã không thành công. 

Nhận Thư (Receive Mail) 

Nếu máy gửi có thể liên lạc được với máy nhận thì việc chuyển thư 

sẽ được tiến hành. Trước khi nhận lá thư thì máy nhận sẽ kiểm soát tên 

người nhận có hộp thư trên máy nhận hay không. Nếu tên người nhận thư có 

hộp thư trên máy nhận thì lá thư sẽ được nhận lấy và thư sẽ được bỏ vào 

hộp thư của người nhận. Trường hợp nếu máy nhận kiểm soát thấy rằng 

tên người nhận không có hộp thư thì máy nhận sẽ khước từ việc nhận lá thư. 

Trong trường hợp khước từ này thì máy gửi sẽ thông báo cho người gửi biết 

là người nhận không có hộp thư (user unknown). 

Trạm Phục Vụ Thư (Mail Server) 

Trên thực tế, trong những cơ quan và hãng xưởng lớn, máy vi tính 

của người gửi thư không gửi trực tiếp tới máy vi tính của người nhận mà 

thường qua các máy chủ thư điện tử (mail servers). 

Ví dụ: quá trình gửi thư 

 

 
 

Hình 3.1.: Gửi thư từ A đến B 

Như Hình 1.1. cho thấy, nếu như một người ở máy A gửi tới một 

người ở máy B một lá thư thì trước nhất máy A sẽ gửi đến máy chủ thư 

điện tử X. Khi trạm phục vụ thư X nhận được thư từ máy A thì X sẽ 

chuyển tiếp cho máy chủ thư điện tử Y. Khi trạm phục vụ thư Y nhận 
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được thư từ X thì Y sẽ chuyển thư tới máy B là nơi người nhận. Trường 

hợp máy B bị trục trặc thì máy chủ thư Y sẽ giữ thư. 

2.1. Những nhân tố cơ bản của hệ thống thư điện tử 

Mục tiêu: Giới thiệu cho người dùng các ứng dụng của dịch vụ thư điện tử 

cũng như cơ chế truyền thư của các ứng dụng đó 

Hầu hết hệt thống thư điện tử được chia làm các phần như sau : 

- Mail User Agent (MUA) 

- Mail Transfer Agent (MTA) 

- Mail Delivery Agent (MDA) 

Mail User Agent (MUA) — Là ứng dụng cho phép người dùng có 

thể truy nhập vào mail server để lấy về các thư của người dùng (sử  dụng 

POP) hoặc xem trực tiếp thư trên server (sử dụng IMAP) MUA còn cho 

phép người dùng tạo và gửi thư. Thư được chuyển đến MTA quản  lý  

người dùng (sử dụng SMTP). MUA không trực tiếp chuyển thư đến 

người nhận. Các phần mềm ứng dụng thông dụng của MUAs là Outlook 

Express, Microsoft  Outlook, Windows mail và Pine ... 

Mail Transfer Agent (MTA) — MTA là ứng dụng cho phép gửi 

và nhận thư sử dụng SMTP. Cho các thư chuyển đi MTA xác định địa chỉ 

của người nhận và xác định nếu địa chỉ người nhận ngay tại hệ thông thì 

nó sẽ 

chuyển trực tiếp vào hộp thư của người nhận tại hệ thống hoặc thông 

qua MDA để chuyển đi. Nếu người nhận là một địa chỉ khác thì MTA sẽ 

thiết lập kết nối đến một MTA quản lý người nhận để chuyển thư đến sử 

dụng giao thức SMTP. Các ví dụ về các phần mềm quản lý mail MTA 

là: Mdaemon, Exchange server, sendMail, Qmail ... 

Mail Delivery Agent (MDA) — Là một chương trình được MTA 

sử dụng để đẩy các bản tin vào hộp thư của người dùng và có tác dụng 

lọc kiểm tra thư trước khi chuyển vào hộp thư người sử dụng. 

Chú ý: Các sản phẩm thương mại thường ẩn dấu những khác biệt 

giữa các nhân tố logic này với người dùng. Ví dụ chương trình Microsoft 

Exchange có ít nhất một MTA, cộng thêm vài MDA. 

Dưới đây là sơ đồ tổng quan của hệ thống thư điện tử. 
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Hình 3.2. Sơ đồ tổng quan hệ thống thư điện tử Chúng ta sẽ dần 

dần tìm hiểu kỹ các nhân tố này. 

MTA - Những nhiệm vụ chính 

Khi các bức thư được gửi đến từ MUA. MTA có nhiệm vụ nhận 

diện người gửi và người nhận từ thông tin đóng gói trong phần header 

của thư và điền các thông tin cần thiết vào đó. Sau đó MTA chuyển thư cho 

MDA để MDA chuyển đến hộp thư ngay tại MTA hoặc đến MTA khác. 

Chú ý: Thông tin đóng gói được thêm vào thư như một phần của giao 

thức SMTP. Nó thường được thêm vào hay thay đổi tự động bởi phần mềm 

hệ thống thư. 

Các bức thư có thể chuyển qua nhiều MTA và được viết lại vài lần, 

đặc biệt khi cần phải chuyển sang các định dạng riêng. Một phần hay cả bức 

thư có thể phải viết lại tại bởi các MTA trên đường đi. 

Việc chuyển giao các bức thư được các MTA quyết định dựa trên 

địa chỉ người nhận tìm thấy trên phong bì: 

- Nếu nó trùng với hộp thư địa phương, bức thư được chuyển cho MDA 

- địa phương để chuyển cho hộp thư. 

- Nếu địa chỉ gửi bị lỗi, bức thư có thể được chuyển trở lại người gửi. 

- Nếu không bị lỗi nhưng không phải là bức thư địa phương (non- 

local), tên miền (domain) được sử dụng để quyết định xem server nào 

sẽ nhận thư, theo các bản ghi MX trên hệ thống tên miền (chúng ta 

sẽ đi sâu vào các khái niệm DNS và domain trong các mục phía sau) 

- Khi các bản ghi MX xác định được MTA quản lý tên miền đó thì không 

có nghĩa là người nhận thuộc địa phương vùng đó. MTA có thể đơn giản 

chung chuyển (relay) thư cho MTA khác, hoặc có thể định tuyến bức 

thư cho địa chỉ khác như vai trò của một dịch vụ domain ảo (domain 

gateway), ví dụ như thay đổi thông tin người nhận trên phong bì trước 

khi chuyển thư đi. 

- MUA (Mail User Agent) 
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- MUA là chương trình quản lý thư đầu cuối cho phép người dùng có thể 

đọc, viết và lấy thư về từ MTA. 

+ MUA có thể lấy thư từ MTA về để xử lý (sử dụng POP) hoặc chuyển 

tiếp đến một MTA khác (SMTP). 

+ Hoặc MUA có thể xử lý trực tiếp thư ngay trên MTA (sử dụng IMAP). 

- Đằng sau những công việc vận chuyển thì chức năng chính của MUA là 

cung cấp giao diện cho người dùng tương tác với thư, gồm có: 

- Soạn thảo, gửi thư 

- Hiển thị thư, gồm cả các file đính kèm 

- Gửi trả hay chuyển tiếp thư 

- Gắn các file vào các thư gửi đi (Text, HTML, MIME .v.v. ) Thay đổi các 

tham số (ví dụ như server được sử dụng, kiểu hiển thị thư, kiểu mã hóa 

thư .v.v.) 

- Thao tác trên các thư mục thư địa phương và ở đầu xa 

- Cung cấp sổ địa chỉ thư (danh bạ địa chỉ) 

- Lọc thư 

 
Hình 3.3.: Hoạt động của MTA, MUA 

 Để có thể hiểu rõ về các giao thức này cũng như về hệ thống thư điện tử, 

các bạn hãy tìm hiểu tại các mục phía sau. 

2.2. Giới thiệu về giao thức SMTP 

Công việc phát triển các hệ thống thư điện tử (Mail System) đòi 

hỏi phải hình thành  các chuẩn chung về thư điện tử. Điều này giúp cho 

việc gửi, nhận các thông điệp được đảm bảo, làm cho những người ở các 

nơi khác nhau có thể trao đổi thông tin cho nhau. 

Có 2 chuẩn về thư điện tử quan trọng nhất và được sử dụng nhiều 

nhất từ trước đến nay là X.400 và SMTP (Simple Mail Transfer Protocol). 

SMTP thường đi kèm với chuẩn POP3. Mục đích chính của X.400 là cho 

phép các E- mail có thể được truyền nhận thông qua các loại mạng khác 

nhau bất chấp cấu hình phần cứng, hệ điều hành mạng, giao thức truyền 

dẫn được dùng. Còn chuẩn SMTP miêu tả cách điều khiển các thông điệp 

trên mạng Internet. Điều quan trọng của chuẩn SMTP là giả định máy nhận 
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phải dùng giao thức SMTP gửi thư điện tử cho một máy chủ luôn luôn 

hoạt động. Sau đó, người nhận sẽ đến lấy thư từ máy chủ khi nào họ 

muốn dùng giao  thức  POP (Post Office Protocol), ngày nay POP được cải 

tiến thành POP3 (Post Officce Protocol version 3). 

 
Hình 3.4.: Hoạt động của POP và SMTP 

Thủ tục chuẩn trên Internet để nhận và gửi của thư điện tử là 

SMTP (Simple Mail Transport Protocol). SMTP là thủ tục phát triển ở mức 

ứng dụng trong mô hình 7 lớp OSI cho phép gửi các bức điện trên mạng 

TCP/IP. SMTP được phát triển vào năm 1982 bởi tổ chức  IETF  (Internet  

Engineering Task Force) và được chuẩn hoá theo tiêu chuẩn RFCs 821 và 

822. SMTP sử dụng cổng 25 của TCP. 

Mặc dù SMTP là thủ tục gửi và nhận thư điện tử phổ biến nhất 

nhưng nó vẫn còn thiếu một số đặc điểm quan trọng có trong thủ tục X400. 

Phần yếu nhất của SMTP là thiếu khả năng hỗ trợ cho các bức điện 

không phải dạng Text. 

Ngoài ra SMTP cũng có kết hợp thêm hai thủ tục khác hỗ trợ cho 

việc lấy thư là POP3 và IMAP4. 

MIME và SMTP 

MIME (Multipurpose Internet Mail Extensions) cung cấp  thêm  khả 

năng cho SMTP và cho phép các file có dạng mã hoá đa phương tiện 

(multimedia) đi kèm với bức điện SMTP chuẩn. MIME sử dụng bảng mã 

Base64 để chuyển các file dạng phức tạp sang mã ASCII để chuyển đi. 

MIME là một tiêu chuẩn mới như nó hiện đã được hỗ trợ bởi hầu 

hết các ứng dụng, và bạn phải thay đổi nếu chương trình thư điện tử của 

bạn không có hỗ trợ MIME. MIME được quy chuẩn trong các tiêu chuẩn 

RFC 2045-2049 

S/MIME 

Là một chuẩn mới của MIME cho phép hỗ trợ cho các bức điện 

được mã hoá. S/MIME dựa trên kỹ thuật mã hoá công cộng    RSA   và   
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giúp cho bức điện không bị xem trộm hoặc chặn lấy. 

RSA Public Key/Private Key Authentication 

Viết tắt cho Rivest, Shamir, và Adelman, là những người khám phá 

ra cách mã hoá này, RSA cung cấp cặp khoá public key/private key (khoá 

công cộng/khoá riêng) để mã hoá. Dữ liệu sẽ được mã hoá bởi khoá công 

cộng và chỉ có thể được giải mã bởi khoá riêng. Với S/MIME, người gửi 

sẽ sử dụng một chuỗi mã  hoá ngẫu nhiên sử dụng khoá công cộng của 

người  nhận. Người nhận sẽ giải mã điện bằng cách sử dụng khoá riêng. 

Muốn nghiên cứu kỹ về mã hoá RSA vào trang web http://www.rsa.com 

S/MIME được định nghĩa trong các tiêu chuẩn RFCs 2311 và 2312. 

Lệnh của SMTP 

SMTP sử dụng một cách đơn giản các câu lệnh ngắn để điều 

khiển bức điện. Bảng ở dưới là danh sách các lệnh của SMTP 

Các lệnh của SMTP được xác định trong tiêu chuẩn RFC 821 

Lệnh Mô 

HELO Hello.  Sử  dụng  để  xác  định  người  gửi  điện.  Lệnh 

này này đi kèm  với  tên  của  host  gửi  điện.  Trong 

ESTMP  (extended protocol), thì lệnh này sẽ là EHLO. 

MAIL Khởi tạo một giao dịch gửi thư. Nó kết hợp "from" để 

xác định người gửi thư. 

RCPT Xác định người nhận thư. 

DATA Thông báo bắt đầu nội dung thực sự của bức điện (phần 

thân của thư). Dữ liệu được mã thành dạng mã 128-bit 

ASCII  và nó được kết thúc với một dòng đơn 

RSET Huỷ bỏ giao dịch thư 

VRFY Sử dụng để xác thực người nhận thư. 

NOOP Nó là lệnh  "no operation" xác định không thực hiện hành 

động 

QUIT Thoát khỏi tiến trình để kết thúc 

SEND Cho host nhận biết rằng thư còn phải gửi đến đầu cuối 

Sau đây là những lệnh khác nhưng không yêu cầu phải có. Xác địn bởi 

RFC 
SOML Send or mail. Báo với host nhận thư rằng thư phải gửi 

đến đầu cuối khác hoặc hộp thư. 
SAML Send and mail. Nói với host nhận rằng bức điện phả gửi 

tới người dùng đầu cuối và hộp thư. 

EXPN Sử dụng mở rộng cho một mailing list. 

HELP Yêu cầu thông tin giúp đỡ từ đầu nhận thư. 

http://www.rsa.com/
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TURN Yêu cầu để host nhận giữ vai trò là host gửi thư. 

Mã trạng thái của SMTP 

Khi một MTA gửi một lệnh SMTP tới MTA nhận thì MTA nhận sẽ 

trả lời với một mã trạng thái để cho người gửi biết đang có việc gì xảy ra 

tại đầu nhận. Và dưới đây là bảng mã trạng thái của SMTP theo tiêu 

chuẩn RFC 821. Mức độ của trạng thái được xác định bởi số đầu tiên của 

mã (5xx là lỗi nặng, 4xx là lỗi tạm thời, 1xx–3xx là hoạt động bình thường). 

SMTP mở rộng (Extended SMTP) 

SMTP thì được cải tiến để ngày càng đáp ứng nhu cầu cao của 

người dùng và là một thủ tục ngày càng có ích. Nhưng dù sao cũng cần 

có sự mở rộng tiêu chuẩn SMTP, và chuẩn RFC 1869 ra đời để bổ sung cho 

SMTP. Nó không chỉ mở rộng mà còn cung cấp thêm các tính năng cần thiết 

cho các lệnh có sẵn. Ví dụ: lệnh SIZE là lệnh mở rộng cho phép nhận giới 

hạn độ lớn của bức điện đến. Không có ESMTP thì sẽ không giới hạn 

được độ lớn của bức thư. 

 Khi hệ thống kết nối với một MTA, nó sẽ sử dụng khởi tạo thì 

ESMTP thay HELO bằng EHLO. Nếu MTA có hỗ trợ SMTP mở rộng 

(ESMTP) thì nó sẽ 

trả lời với một danh sách các lệnh mà nó sẽ hỗ trợ. Nếu không nó sẽ trả lời 

với mã lệnh sai (500 Command not recognized) và host gửi sẽ quay trở 

về sử dụng SMTP. 

Các lệnh cơ bản của ESMTP 

Lện Miêu 

EHLO Sử dụng ESMTP thay cho HELO của 

8BITMIME Sử dụng 8-bit MIME cho mã dữ liệu 

SIZE Sử dụng giới hạn độ lớn của bức điện 

SMTP Headers 

Có thể lấy được rất nhiều thông tin có ích bằng cách kiểm tra phần 

header của thư. Không chỉ xem được  bức điện từ đâu đến, chủ đề  của 

thư, ngày gửi và những người nhận. Bạn còn có thể xem được những 

điểm mà bức điện đã đi qua trước khi đến được hộp thư của bạn. Tiêu 

chuẩn RFC 822 quy định header chứa những gì. Tối thiểu có người gửi 

(from), ngày gửi  và người nhận (TO, CC, hoặc BCC) 

Header của thư khi nhận được cho phép bạn xem bức điện đã đi 

qua những đâu trước khi đến hộp thư của bạn. Nó là một dụng cụ rất tốt để 

kiểm tra và giải quyết lỗi. Sau đây là ví dụ: 

Trên  ví dụ trên có thể thấy bức điện được  gửi đi 

từ someone@mydomain.com. Từ mydomain.com, nó được chuyển đến 

host1. Bức điện được gửi từ host2 tới host1 và chuyển tới người dùng. Mỗi 

mailto:someone@mydomain.com
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chỗ bức điện dừng lại thì host nhận được yêu cầu điền thêm thông tin vào 

header nó bao gồm ngày giờ tạm dừng ở  đó.  Host2  thông  báo  rằng  nó  

nhận  được điện lúc 11:33:00. Host1 thông báo rằng nó nhận được bức 

điện vào lúc 11:34:36, Sự chênh lệch hơn một phút có khả năng là do sự 

không đồng bộ giữa đồng hồ của hai nơi. 

Thuận lợi và bất lợi của SMTP 

Như thủ tục X.400, SMTP có một số thuận lợi và bất lợi 

Thuận lợi bao gồm: 

- SMTP rất phổ biến. 

- Nó được hỗ trợ bởi nhiều tổ chức 

- .SMTP có giá thành quản trị và duy trì thấp. 

- SMTP nó có cấu trúc địa chỉ đơn giản. 

Bất lợi bao gồm: 

- SMTP thiếu một số chức năng 

- SMTP thiếu khả năng bảo mật như X.400. 

- Nó chỉ giới hạn vào những tính năng đơn giản nhất. 

2.3. Giới thiệu về giao thức POP và IMAP 

Trong nhưng ngày tháng đầu tiên của thư điện tử, người dùng được 

yêu cầu truy  nhập  vào  máy  chủ  thư  điện  tử  và  đọc  các  bức  điện  của  

họ ở đó. Các chương trình thư thường sử dụng dạng  text  và  thiếu khả  

năng thân thiện với người dùng. Để giải quyết vấn  đề  đó  một  số  thủ  tục  

được phát triển để cho phép người dùng có thể lấy thư về máy của họ hoặc 

có các giao diện sử dụng thân thiện hơn với người dùng. Và chính điều đó 

đem đến sự phổ biến của thư điện tử. 

Có hai thủ tục được sử dụng phổ biến nhất để lấy thư về hiện nay 

là POP (Post Office Protocol) và IMAP (Internet Mail Access Protocol). 

Post Office Protocol (POP) 

POP cho phép người dùng có account tại máy chủ thư điện tử kết 

nối vào MTA và lấy thư về máy tính của mình, ở đó có thể đọc và trả lời lại. 

POP được phát triển đầu tiên là vào năm 1984 và được nâng cấp từ bản 

POP2 lên POP3 vào năm 1988. Và hiện nay hầu hết người dùng sử dụng 

tiêu chuẩn POP3 

POP3 kết nối trên nền TCP/IP để đến máy chủ thư điện tử (sử 

dụng cổng 110). Người dùng điền username và password. Sau khi xác thực 

đầu máy khách sẽ sử dụng các lệnh của POP3 để lấy hoặc xoá thư. 

POP3 chỉ là thủ tục để lấy thư trên máy chủ thư điện tử. POP3 

được quy định bởi tiêu chuẩn RFC 1939. 

Lệnh của POP3 

Lệnh Miêu tả 
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USER Xác định username 

PASS Xác định password 

STAT Yêu  cầu  về  trạng  thái  của  hộp  thư  như  số 

lượng thư và độ lớn của thư 
LIST Hiện danh sách của thư 

RETR Nhận thư 

DELE Xoá một bức thư xác định 

NOOP Không làm gì cả 

RSET Khôi phục lại những thư đã xoá (rollback) 

QUIT Thực hiện việc thay đổi và thoát ra 

Internet Mail Access Protocol (IMAP) 

Thủ tục POP3 là một thủ tục rất có ích và sử dụng rất đơn giản để 

lấy thư về cho người dùng. Nhưng sự đơn giản đó cũng đem đến việc 

thiếu một số công dụng cần thiết. Ví dụ: POP3 chỉ làm  việc  với  chế  độ  

offline  có nghĩa là thư được lấy về sẽ bị xoá trên server. 

IMAP thì hỗ  trợ những thiếu  sót của  POP3. IMAP được  phát triển 

vào năm 1986 bởi trường đại học Stanford. IMAP2 phát triển vào năm 

1987. IMAP4, là bản mới nhất đang được sử dụng và nó được các tổ 

chức tiêu chuẩn Internet chấp nhận vào năm 1994. IMAP4 được quy định 

bởi tiêu chuẩn RFC 2060 và nó sử dụng cổng 143 của TCP 

Lệnh của IMAP4 

Lệnh Miêu tả 

CAPABILITY Yêu cầu danh sách các chức năng hỗ trợ 

AUTHENTICAT

E 

Xác định sử dụng xác thực từ một server khác 

LOGIN Cung cấp username và password 

SELECT Chọn hộp thư 

EXAMINE Điền hộp thư chỉ được phép đọc 

Lện Miêu tả 

CREATE Tạo hộp thư 

DELETE Xoá hộp thư 

RENAME Đổi tên hộp thư 

SUBSCRIBE Thêm vào một list đang hoạt động 

UNSUBSCRIB Dời khỏi list đang hoạt động 

LIST Danh sách hộp thư 

LSUB Hiện danh sách người sử dụng hộp thư 

STATUS Trạng thái của hộp thư (số lượng thư,...) 

APPEND Thêm message vào hộp thư 

CHECK Yêu cầu kiểm tra hộp thư 

CLOSE Thực hiện xoá và thoát khỏi hộp thư 
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EXPUNGE Thực hiện xoá 

SEARCH Tìm kiếm trong hộp thư để tìm messages 

xác 

định FETCH Tìm kiếm trong nội dung của message 

STORE Thay đổi nội dụng của messages 

COPY Copy message sang hộp thư khác 

NOOP Không làm gì 

LOGOUT Đóng kết nối 

So sánh POP3 và IMAP4 

Có rất nhiều điểm khác nhau giữa POP3 và IMAP4. Phụ thuộc 

vào người dùng, MTA, và sự cần thiết , Có thể sử dụng POP3, IMAP4 hoặc 

cả hai. 

Lợi ích của POP3 là : 

- Rất đơn giản. 

- Được hỗ trợ rất rộng 

- Bởi rất đơn giản nên POP3 có rất nhiều giới hạn. Ví dụ nó chỉ hỗ trợ sử 

dụng một hộp thư và thư sẽ được xoá khỏi máy chủ thư điện tử khi lấy về 

IMAP4 có những lợi ích khác: 

- Hỗ trợ xác thực rất mạnh 

- Hỗ trợ sử dụng nhiều hộp thư 

- Đặc biệt hỗ trợ cho các chế việc làm việc  online, offline, hoặc không kết 

nối IMAP4 ở chế độ online thì hỗ trợ cho việc lấy tập hợp các thư từ máy 

chủ, tìm kiếm và lấy message cần tìm về ...IMAP4 cũng cho phép người 

dùng chuyển thư từ thư mục này của máy chủ sang thư mục khác hoặc 

xoá thư. IMAP4 hỗ trợ rất tốt cho người dùng hay phải di chuyển và 

phải sử dụng các máy tính khác nhau. 

3. Giới thiệu về cấu trúc của địa chỉ thư điện tử 

Thư điện tử (E-mail) được cấu tạo tương tự như những bức thư 

thông thường và chia làm hai phần chính: 

- Phần đầu (header) chứa tên và địa chỉ của người nhận, tên và địa chỉ của 

những người sẽ được chuyển đến, chủ đề của thư (subject). Tên và địa chỉ 

của người gửi, ngày tháng của bức thư. 

- Thân của thư (body) chứa nội dung của bức thư. 

Như khi gửi các bức thư bình thường bạn cần phải có địa chỉ chính xác. 

Nếu sử dụng sai điạ chỉ hoặc gõ nhầm địa chỉ, thì thư sẽ không thể gửi 

đến người nhận và nó sẽ chuyển lại cho người gửi, và báo  địa  chỉ không 

biết (Address Unknown). Khi nhận được một thư điện tử, thì phần đầu 

(header) của thư sẽ cho biết nó từ đâu đến, và nó đã được gửi đi như thế 

nào và khi nào. Nó như việc đóng dấu bưu điện. 
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Không như những bức thư thông thường, những bức thư thông thường 

được để trong phong bì còn thư điện tử thì không được riêng tư như vậy 

mà nó như một tấm thiếp postcard. Thư điện tử có thể bị chặn lại và bị 

đọc bởi những người không  được quyền đọc.  Để  tránh điều đó  và  giữ bí 

mật chỉ có cách mã hóa thông tin gửi trong thư 

Địa chỉ thư điện tử 

Tương tự như việc gửi thư bằng bưu điện, việc gửi nhận thư điện 

tử cũng cần phải có địa chỉ của nơi gửi và địa chỉ của nơi nhận. Địa chỉ 

của E- Mail được theo cấu trúc như sau: user-mailbox@domain-part 

(Hộp- thư@vùng quản lý). Với user-mailbox là địa chỉ của hộp thư người 

nhận. Có thể hiểu như số nhà và tên đường như thư bưu điện. Vùng quản 

lý tên miền (domain-part) là khu vực quản lý của người nhận trên Internet. 

Có thể hiểu nó giống như tên thành phố, tên tỉnh và quốc gia như địa chỉ 

nhà trên thư bưu điện. 

Tóm lại địa chỉ thư điện tử thường có hai phần chính: ví dụ 

ktm@vdc.com.vn Phần trước là phần tên của người dùng user name (ktm) 

nó thường là hộp thư của người nhận thư trên máy chủ thư điện tử. Sau 

đó là phần đánh dấu (@). Cuối cùng là phần tên miền xác định địa chỉ 

máy chủ thư điện tử quản lý thư điện tử mà người dùng đăng ký 

(vdc.com.vn) và có hộp thư trên đó. Nó thường là tên của một cơ quan 

hoặc một tổ chức và nó hoạt động dựa trên hoạt động của hệ thống tên 

miền. 

Phần cuối của domain cho biết địa chỉ ở đâu hoặc thuộc về nước 

nào quản lý hay thuộc tổ chức nào. Ví dụ như: 

VN -- Việt nam. COM-- Thương mại. 

EDU -- Các trường  Đại Học. GOV -- Cơ quan chính quyền. MIL  -- Quân 

đội. 

NET -- Những trung tâm lớn cung cấp dịch vụ Internet. ORG-- Những hội 

đoàn. 

CA   -- Canada. 

AU   -- Australi. v.v... 

Câu hỏi 

 

Kiến thức: 

Câu 1: Trình bày cấu trúc và hoạt động của thư điện tử 

Câu2: Trình bày cấu trúc địa chỉ của thư điện tử 

Câu 3: Phân biệt sự khác nhau giữa các giao thức: POP3, IMAP, SMTP 

mailto:ktm@vdc.com.vn
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BÀI 4 . GIỚI THIỆU VỀ MAIL EXCHAGE SERVER 2010 

Mã bài: 19.4 

 

Giới thiệu 

 Giới thiệu cho người học về các phần mềm quản lý thư điện tử thông giúp 

người học hiểu và phân biệt được các tính năng, những cải tiếncủa MS 

Exchange 2010 

Mục tiêu: 

- Sử dụng được phần mềm quản trị Mail Server; 

- Sử dụng được các tính năng truy cập của Client; 

- So sánh được những cải tiến của phần mềm Mail Server so với những phiên 

bản khác nhau; 

- Phân biệt, đánh giá được các ưu điểm của từng hệ thống Mail server khác 

nhau, từ đó có thể lựa chọn chương trình quản lý mail server phù. 

- Thực hiện các thao tác an toàn với máy tính. 

Nội dung chính: 

1. Mail Server là gì? 

Exchange Server là phần mềm của Microsoft, chạy trên các máy chủ, 

cho phép gửi và nhận thư điện tử cũng như các dạng khác của truyền thông 

thông qua mạng máy tính. Được thiết kế chủ yếu để  giao  tiếp  với  

Microsoft Outlook nhưng Exchange Server cũng có thể giao tiếp tốt với các 

phần mềm khác như Outlook Express hay các ứng dụng thư điện tử khác. 

Exchange Server được thiết kế cho cả các doanh nghiệp lớn và nhỏ với 

ưu điểm nổi trội là dễ quản trị, hỗ trợ nhiều tính năng và có độ tin cậy cao. Sự 

dễ sử dụng của các công cụ triển khai và hỗ trợ cho phép ta dễ dàng quản trị 

Exchange Server hơn. 

Tin nhắn được gửi từ các thiết bị Client như máy tính cá nhân (PC), 

máy trạm hay các thiết bị di động như điện thoại di động hay Pocket PC. Các 

thiết bị Client này kết nối với mạng máy tính tập trung với Server hay các 

máy Mainframe là nơi lưu trữ các hộp thư. Các Server kết nối tới mạng 

Internet hoặc mạng riêng (private network) nơi thư điện tử được gửi tới để 

nhận thư điện tử của người sử dụng. 

2. Các tính năng truy cập của Client 

Exchange Server hỗ trợ các thiết bị di động như Pocket PC hay 

SmartPhone và cho phép bạn đồng bộ hóa các thư mục Inbox, Calendar, 

Contact và danh sách các công việc Task, qua đó bạn có thể kiểm tra các 

thư mục cá nhân của mình từ xa thông qua các thiết bị di động. Các trình 

duyệt trên các thiết bị di động cũng được hỗ trợ thông qua Exchange 

Outlook Mobile Access, điều này cho phép các ứng dụng chạy trên trình 
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duyệt như HTML, CHTML (Compressed HTML), và WAP  (Wireless  

Application  Protocol) truy nhập vào Exchange Server. Sơ đồ sau đây minh 

họa các loại Client được hỗ trợ bởi Exchange Server: 

 

 
 

Hình 4.1 Các tính năng truy cập client của Exchange Server 

 Các  chức  năng hợp  tác  của Exchange  Server  cho phép  ta chia  sẻ  

các thông tin  một cách nhanh chóng và hiệu quả. Có rất nhiều các tính năng 

được hỗ trợ bởi Exchange Server cho phép bạn sử dụng phần mềm một cách 

thoải mái và tiện lợi nhất, các tính năng như đặt chế độ trả lời thư tự động, 

tham gia vào các phòng hội thảo… tất cả đều được hỗ trợ trong phiên bản 

Exchange Server 2003. Để có thể phát huy một cách tốt nhất tất cả các tính 

năng liên kết, hợp tác của Exchange Server, hãy kết hợp Exchange Server 

2003 với Outlook 2003. 

3. Những cải tiến của mail Server exchage 2010 

 Cải tiến phương thức quản lý : Exchange Server 2010 đưa ra mô hình Role-

Based Access Control (RBAC), tạm gọi là quyền hạn điều khiển theo vai trò, là 

sự thay đổi đối lập với mô hình permission-based Access Control List (Danh 

sách điều khiển dựa trên quyền hạn) trong những mô hình trước đây. Đây được 

xem là một trong những cải tiến lớn của Exchange Server giảm tải cho nhà quản 

trị, đồng thời cũng đòi hỏi cân nhắc kỹ lưỡng trong việc phân quyền để tránh sự 

chồng chéo lẫn nhau. 

 Mô hình lưu trữ thông tin mới : Khả năng khôi phục mailbox server sử dụng 

Database Available Group (DAG), chức năng mở rộng hoàn toàn mới từ chức 

năng Cluster Continuous Replication (CCR) đã có trong Exchange Server 2007. 

Nó cho phép người dùng chạy một mailbox server thứ hai nhằm khôi phục 

nhanh khi cần thiết. DAG hoàn toàn không có trong Exchange Server 2003, 

thay thế được các mô hình clustering cổ điển hay lưu trữ thông tin dưới dạng 

Storage Area Network (SAN).   Mô hình DAG có thể tạo đến 16 bản sao chép 
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cho mỗi cơ sở dữ liệu Mailbox. Các bản sao chép dự phòng (replica) có thể 

được cấu hình để chịu lỗi một cách tự động. 

 Đơn giản hóa Archiving : Exchange Server 2010 cho phép di chuyển email từ 

mailbox của họ tới những nơi phù hợp và an toàn hơn mà không cần sử dụng 

những giải pháp của các hãng thứ ba như trước đây. Giải pháp này cũng bao 

gồm cả chức năng Personal Archive, có thể cho xuất hiện trên giao diện 

Microsoft Outlook của người dùng. Có thể tìm kiếm một cách đồng thời với 

nhiều mailbox khác thông qua việc phân quyền và bộ lọc thông tin cao cấp. 

 
Archive giúp lưu trữ email tốt hơn 

 Cho phép phân quyền tự quản trị bằng công cụ ECP : Công cụ mới có giao diện 

web mang tên là Exchange Control Pannel (ECP) sẽ cho phép nhà quản trị làm 

mọi việc trong môi trường Exchange 2010 mà không cần phải cài đặt bất cứ 

một ứng dụng nào trên máy Client (khách). 

 Nâng cấp Server cũng sẽ cần nâng cấp luôn Exchange Server :Windows Server 

2008 R2 hiện chỉ hỗ trợ duy nhất Exchange Server 2010 (không hỗ trợ những 

phiên bản Exchange trước đó). 

 Luồng email qua công cụ CAS :Vai trò của Client Access Server (CAS) sẽ chịu 

trách nhiệm cho tất cả các hình thức kết nối thư bao gồm cả việc kết nối MAPI 

(Outlook) client, cải tiến việc mở rộng hệ thống hạ tầng mail một cách dễ dàng. 

 
Hình 4.2: Mô hình kiến trúc HA (tính sẵn sàng cao) của Exchange Server 2007  
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Hình 4.3: Mô hình HA của Exchange Server 2010 

 Khôi phục đơn :Trong những phiên bản trước của Exchange Server, người dùng 

có thể xóa đi những mục mà họ không thích. Điều này khiến các nhà quản trị 

tốn nhiều thời gian để khôi phục khi có yêu cầu. Exchange Server 2010 cung 

cấp cấp thời gian lưu trữ email lâu hơn để hỗ trợ người dùng khôi phục khi cần. 

Chức năng Litigation Hold có trên một số hạng mục email nhất định ngăn người 

dùng xóa trong mọi trường hợp. 

 OWA premium dành cho firefox : Ngoài Internet Explorer, Exchange Server 

2010 Outlook Web Access (OWA) hỗ trợ các trình duyệt web như Firefox hoặc 

Safari. OWA cũng có thêm những tính năng mới như chia sẻ lịch biểu (Share 

Calendars) hay Contacts, thêm những chức năng tích hợp trạng thái người dùng. 

 Windows Mobile :Người dùng sử dụng smartphone Windows Mobile sẽ có giao 

diện Outlook trên Mobile hoàn toàn mới, đặc biệt là chức năng Conversation 

View cho phép xem hàng loạt email cùng một chủ đề trong một thực thể duy 

nhất. Hơn nữa, các tin nhắn văn bản (text) trên Windows Mobile sẽ được đồng 

bộ tức thì với mailbox của Server. 

 Những cải tiến về tốc độ :Trong Exchange 2007, sự kết hợp giữa kiến trúc 64-

bit và tăng kích cỡ trang tới 8 KB dẫn tới hiệu quả là giảm được 70% việc đọc 

ghi cho Exchange trên đĩa cứng. Với Exchange 2010, kích cỡ trang được tăng 

lên đến 32 KB giúp tốc độ IOPS được giảm thêm 50% nữa. Nhờ đó các doanh 

nghiệp có thể xem xét lại việc dùng những loại đĩa cứng rẻ tiền hơn mà không 

hề mất đi bất cứ khả năng nào của hệ thống. 
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BÀI 5: CÀI ĐẶT MÁY CHỦ MAIL EXCHAGE SERVER 2010 

Mã bài: 19.5 

Giới thiệu: 

 Giúp người học hiểu được quy trình các bước cài đặt phần mềm MS 

Exchange 20010 và cài đặt và cấu hình các dịch vụ trước khi cài đặt 

Mục tiêu : 

- Trình bày được các dịch vụ cần thiết trước khi cài phần mềm Mail Server; 

- Cài đặt, thiết lập và cấu hình được hệ thống Mail Server. 

- Thực hiện các thao tác an toàn với máy tính. 

Nội dung chính: 

Những yêu cầu khi cài đặt Windows Server 2008 R2 

1. Cài OS: Windows Server 2008 R2 Enterprise 64 bit. 

2. Sau đó, thăng cấp máy chủ lên DC với tên miền giả sử là  

ExchangeSRVCorp.com. 

Lưu ý: Đây là kịch bản cài Exchange Server 2010 trên DC đầu tiên của tổ 

chức- DC thuộc Forest. 

Cài đặt Exchange Server 2010 trên Windows Server 2008 R2 

1. Các bước chuẩn bị Cài đặt Exchange Server 2010 

1.1.Yêu cầu phần mềm và phần cứng 

- DVD source Microsoft Windows Server 2008 R2 64bit 

- DVD source exchange server 2010 

 Vì tính chất yêu cầu của exchange 2010 bắt buộc phải được cài đặt trên 

nền windows server 2008 64 bit nên bắt buộc chúng ta phải chuẩn bị một server 

đã cài đăt OS server windows server 2008 R2 64bit. Sau khi cài đặt thì ta sẽ tiến 

hành join domain này vào hệ thống hiện tại và đăng nhập vào server này với 

quyền domain admin. Để cài đặt windows server 2008 và join domain vui lòng 

xem lại bài lab trước. 

Bộ xử lý 

- Tối thiểu: 1 GHz (x86) và 1.4 GHz (x64). 

- Khuyến cáo: 2 GHz hoặc hơn. 

- Lưu ý: Bộ xử lý Intel Itanium 2 được sử dụng cho Windows Server 2008 R2 

Itanium-Based Systems. 

Hệ điều hành 

Trên hệ thống 32 bit:  

    Windows Server 2008 R2 Standard: 4 GB RAM 

    Windows Server 2008 R2 Enterprise và Datacenter: 64 GB RAM 

Trên hệ thống 64 bit: 

    Windows Server 2008 R2 Standard: 32 GB RAM 

    Windows Server 2008 R2 Enterprise và Datacenter: 1 TB và 2 TB (Itanium-
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Based Systems). 

- Không gian đĩa trống:    40 GB trở lên. Lưu ý: Nếu máy tính của bạn có 

RAM > 16 GB thì yêu cầu không gian đĩa trống phải lớn dành cho các files: 

Paging, Hibernation và Dump. 

- Bộ nhớ :  Phụ thuộc vào những tính năng của Exchange mà bạn cài đặt thì bộ 

nhớ yêu cầu sẽ khác nhau như bảng dưới đây: 

 
- Các phiên bản Exchange tương thích với Exchange Server 2010 

    Exchange Server 2K3. 

    Exchange Server 2K7. 

    Mixed Exchange Server 2K7 và Exchange Server 2K3. 

  Không thể nâng cấp từ trực tiếp từ Exchange 2000 Server lên Exchange 

Server 2010. 

 Muốn nâng cấp Exchange 2000 Server lên Exchange Server 2010 ta phải 

nâng cấp Exchange 2000 Server lên Exchange Server 2K3 hoặc Exchange 

Server 2K7 rồi sau đó nâng cấp lên Exchange Server 2010. 

II-2. Những yêu cầu về phần cứng 

1.2.Cài đặt các thành phần yêu cầu của exchange 2010 

 Trước khi cài đặt exchange 2010 ta phải cài đặt các thành phần yêu cầu 

của exchange. Các thành phần yêu cầu của exchange như bên dưới 

a. Web Server 

- Security 

- Basic Authentication 

- Windows Authenticaton 

- Digest Authentication 

- Performance 
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- Static content compression 

- Dynamic content compression 

- Management Tools 

- IIS Management console 

- IIS 6 Management Compatibility 

- IIS 6 metabase compatibility 

- IIS 6 WMI compatibility 

- IIS 6 scripting tools 

- IIS 6 management console 

Để cài đặt web server và các module của web server ta vào start à Server 

Manager 

 
Click Add Roles à click Next 

Chọn Web Server à click Next 2 lần 
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Chọn các services như yêu cầu bên trên 

 
Click Next -> click install để bắt đầu cài đặt à click close để đóng cửa sổ add 

role. 

 
b. Server Feature 

Download Microsoft .NET Framework 3.5 SP1 dành cho Windows Server 

2008 R2 x64 theo link:http://www.microsoft.com/download/...7942 

Download Windows PowerShell v2.0 dành cho Windows Server 2008 R2 

x64 theo link:http://www.microsoft.com/download/...20430 

- Net Framework 3.5 SP1 

- HTTP activation 

- RPC Over HTTP Proxy 

- Remote server administration tools 

- AD DS and AD LDS Tools 
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Tại server manager à click Features -> Add Features 

 
Chọn các features đã liệt kê ở trên Và click next 3 lần -> click install 

 
Click close và hệ thống sẽ yêu cầu khởi động lại à khởi động lại máy. 

c. Net Tcp Port Sharing mode automatic 

 
2. Cài đặt exchange 2010 

 Trước khi cài đặt exchange 2010 ta phải tiến hành chuẩn bị qua nhiều giai 

đoạn khác nhau và có lẽ đây là giai đoạn liền kề và cũng là cuối cùng trước khi 
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tiến hành cài đặt một exchange 2010. Để cài đặt exchange 2010 ngòai các 

component yêu cầu ta phải chuẩn bị môi trường cho exchange.  

 Mở CMD à chuyển tới thư mục chứa source exchange 2010 àlần lượt gõ 

các lệnh sau: 

Setup.com /PrepareLegacyExchangePermissions : exchange 2003 sử dụng 

Receipient Update Service (RUS) để cập nhập danh sách địa chỉ và địa chỉ 

email trong AD nhưng trong exchange 2010 tính năng này được thay thế bởi 

Email 

Address Policy. Tham số /PrepareLegacyExchangePermissions dùng để 

chuẩn bị cho 2 hệ thống exchange cùng có thể tồn tại trên cùng một AD. 

 
Setup.com /PrepareSchema : lệnh này dùng để mở rộng AD schema cho 

exchange 2010 

Setup.com /PrepareAD : lệnh này sẽ update hệ thống exchange hiện tại 

và lưu thông tin cấu hình trên AD hỗ trợ exchange 2010. Trong exchange 2003 

thông tin được lưu trong ―First Administrative Group‖. Và tương tự exchange 

2010 sẽ tạo một Administrative Group với tên ―Exchange Administrative 

Group (FYDIBOHF23SPDLT)‖ để lưu thông tin của exchange 2010. Và phần 

này sẽ được hiển thị thông qua System Manager của exchange 2003. 

Nếu đã đến được phần này, có nghĩa là bạn đã hoàn thành tất cả các điều 

kiện tiên quyết, hãy bắt đầu quá trình cài đặt. 

Chạy setup.exe từ folder cài đặt hoặc đĩa CD, một menu cài đặt sẽ xuất 

hiện 

Như bạn có thể thấy, .Net framework 3.5 và windows power shell đã được 

cài đặt, vậy nên các lựa chọn này đã được tô màu xám. Nếu chúng vẫn chưa 

được cài đặt, bạn vẫn có thể cài đặt chúng ở bước này. 

Chọn gói ngôn ngữ cho Exchange 2010; trong trường hợp này, chúng tôi 

chọn tất cả các ngôn ngữ từ DVD. 

Chọn tiếp bước 4: Cài đặt Microsoft Exchange 

Kích vào Next và chấp nhận các điều khoản trong License agreement 

(chắc chắn bạn biết điều gì sẽ xảy ra nếu không chấp nhận các điều khoản này). 
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 Kích Next và chọn tham gia vào thông báo lỗi - Error reporting - hoặc 

không. 

 
Kích vào Next và chọn Select Typical Exchange Server Installation. 
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Giải thích: Một số role exchange không thể cùng tồn tại trên cùng một 

server, ví như Edge Transport và unified Messaging Role. Nếu cần các role này 

bạn sẽ phải chọn ―Custom Exchange Server Installation‖. Hãy chú ý rằng nếu 

bạn chọn ―Edge Transport‖ hoặc ―Unified Messaging Role‖ bạn sẽ không thể 

cài đặt role khác trên cùng một server và ngược lại. 

Trong trường hợp thử nghiệm, chúng tôi không cài đặt Unified Messaging 

hoặc Edge Transport. Các role này yêu cầu nhiều tùy biến và có thể thêm bất kì 

lúc nào sau lần cài đặt đầu tiên. Vậy nên, chúng tôi sẽ bỏ qua chúng. Kích Next 

và đổi tên ―First Organization‖ sang tên của công ty/tổ chức của bạn. Chúng 

tôi sẽ đổi tên hành ―New York‖. 

 
Tiếp đến, kích Next và chọn nếu bạn có muốn kích hoạt Public Folders 

hay không. Trong các phiên bản trước của Exchange, chúng tôi thường sử dụng 

các folder này. Trên exchange 2007 và 2010 chúng ta có thể cài đặt exchange 

mà không cần cơ sở dữ liệu của folder public. 

Trong thử nghiệm, chúng tôi sẽ không sử dụng Public Folders nên chọn 

No, xác nhận rằng chúng tôi không có bất kì tài khoản nào của Outlook 2003. 

Hãy chú ý rằng, bạn vẫn có thể thêm các Public Folders sau khi cài đặt. 
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 Tiếp đến, kích Next và điền địa chỉ Public Client Access server của bạn 

vào. Đây sẽ là địa chỉ mà tất cả người dùng sử dụng để truy cập vào Outlook 

web access, kích hoạt đồng bộ hóa,.. 

Xác nhận FQDN và chọn next ->>Chọn bạn có muốn tham gia vào 

chương trình Customer Improvement Program hay không. Chúng tôi chọn No 

Giờ kích tiếp vào Next để bắt đầu kiểm tra 

Cài đặt Exchange sẽ chạy một kiểm tra và xác nhận rằng nó đã sẵn sàng 

để cài đặt. 

Bạn có thể chạy nó trước khi chạy cài đặt exchange; Chúng tôi muốn chạy 

nó với giao diện GUI. 

Nếu exchange đã sẵn sàng, nút Install sẽ hiển thị. Nếu bạn thiếu một vài 

bước nào đó, cài đặt exchange sẽ không thể tiếp tục và dẫn bạn tới cài đặt các 

yêu cầu còn thiếu với một nút Retry được kích hoạt. 

Nếu nhận được màn hình như bên trên, có nghĩa là bạn đã có thể cài đặt 

tiếp. Kích vào nút Install và chờ đợi trong vài phút. 

 Đây là cài đặt được hướng dẫn từng bước một cho một server đơn chạy tất 

cả các role ngoại trừ role unified messaging và Edge Transport. Cài đặt 

Exchange thực sự vẫn là một tác vụ phức tạp. Nếu bạn đang cài đặt trong môi 

trường thực tế, nó còn liên quan tới việc thiết kế và lên kế hoạch cho cơ sở hạ 

tầng exchange trước khi thực thi bất kì role nào. Trong một số trường hợp, bạn 

có thể phải tích hợp từ các phiên bản trước của exchange; bạn sẽ phải thực hiện 

một tích hợp từ các server mail khác 

Mail Client hỗ trợ tốt nhất với Exchange Server 2010: 

    Outlook 2010 

    Outlook 2007 

    Outlook 2003 

    Entourage 2008 dành cho Mac, Web Services Edition. 
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BÀI 6: QUẢN LÝ MAILBOX SERVERS 

Mã bài: 19.6 

Giới Thiệu 

 Trong các bài lab trước chúng tôi đã hướng dẫn các bạn cách cài đặt cài 

đặt exchange 2010. Trong bài lab này chúng ta sẽ tiếp tục tìm hiểu về công cụ 

quản lý của exchange, cách thức cấu hình mailbox servers role, cấu hình public 

folders. 

Mục Đích 

- Tìm hiểu về công cụ quản lý exchange management console và exchange 

management shell 

- Cấu hình mailbox server roles 

- Cấu hình public folders 

Nội dung chính: 

Hình 6.1: Mô Hình LAB 

 

 
1.Yêu cầu 

Mô hình lab sẽ bao gồm 3 máy: 

- DC2008: đóng vai trò server AD2008 đã được chuyển đổi các role từ 

DC2003 qua 

- EX2010: đóng vai trò server EX2010 trong hệ thống và đã được chuyển đổi 

các mailbox, public folder và system folder từ EX2003 qua. 

- EX2010-2: đóng vai trò server exchange thứ 2 trong hệ thống 

2.Tìm hiểu công cụ quản lý exchange 

 Công cụ exchange management console cung cấp cho bạn giao diện thân 

thiện hỗ trợ bạn quản lý exchange server 2010. Người quản lý chuyên nghiệp 

cần hiểu được các thành phần cấu hình của exchange server 2010 và cơ bản về 

exchange management shell. Trong phần này chúng ta sẽ tìm hiểu về các công 
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cụ quản lý này 

8.1. Exchange management console 

 Công cụ exchange management console dùng mô hình MMC bao gồm 4 

cửa sổ. Trong đó thanh bên trái là phần quản lý chính, bao gồm 4 thành phần: 

Organization Configuration, Server Configuration, Recipient Configuration và 

Toolbox. Mỗi phần này có từng chức năng riêng biệt. 

 
 Organization Configuration 

 Trong organization configuration chứa các thông số cấu hình của từng 

server role mà nó ảnh huởng lên từng hệ thống có liên quan đến nó. Trong phần 

này cho phép bạn quản lý database, activesync policy, journal rules và transport 

rules, thống số định dạng email, quản lý email domain 

 Server Configuration 

 Nơi lưu thông tin cấu hình cho mỗi exchange server trong toàn bộ hệ 

thống. Cấu hình mà bạn có thể quản lý ở đây như: cấu hình phân tích log hệ 

thống, quản lý license exchange server, quản lý cấu hình máy chủ phục vụ việc 

truy cập outlook web. 

 Recipient Configuration 

 Tại recipient configuration dùng để quản lý mailbox, tạo mới mailbox, cấu 

hình distribution groups và contact. Bạn cũng có thể dùng để di chuyển hoặc tái 

tạo kết nối một mailbox tại đây. 

 Toolbox 

 Trong toolbox chứa nhiều công cụ tại đây ta có thể theo dõi, xử lý và quản 

lý exchange server. Những công cụ này bao gồm như exchange best practices 

analyzer, public folder management console, messaging tracking, database 

recovery management 

8.2. Exchange management shell 

 Exchange management shell và exchange management console chạy trên 

nền windows powershell 2.0. Chúng dùng cmdlet, đây là lệnh để chạy trên 
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windows powershell. Mỗi cmdlet chứa một chức năng thực thi độc lập, bạn có 

thể kết hợp nhiều cmdlet để thực thi nhiều lệnh phức tạp. 

 

 
Sau khi đã tạo xong database sales thì ta quan sát thư mục mailbox sẽ có các 

file & folder như trong hình 

 
 

Cấu hình giới hạn mailbox sales 

Mở exchange management console ->organization configuration ->mailbox 

->click phải lên mailbox sales vừa tạo chọn properties 
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Tại sales properties ->  tab limit khai báo các thông số sau: 

- Issue warning at (KB): 850000 thông báo user khi dung lượng mailbox của họ 

đạt tới 850MB 

- Prohibit send at (KB): 1024000 không cho gửi mail khi mailbox đat ngưỡng 

1GB 

- Prohibit send and receive at (KB): 1024000 không cho gửi và nhận mail khi 

mailbox đạt ngưỡng 1GB 

- Warning message interval chu kỳ đưa ra thông báo warning khi user đạt tới 

ngưỡng issue warning ở trên 

- Keep deleted item for (days) giữ lại message trong deleted thư mục của từng 

cá nhân trong bao nhiêu ngày. 

- Keep deleted mailbox for (days) giữ lại mailbox trong bao nhiêu ngày sau khi 

delete. 

Click OK sau khi đã khai báo các thông số. 

 
8.3.  Di chuyển mailbox database tới một nơi lưu trữ khác 

Mở exchange management console ->organization configuration ->mailbox 

->chọn tab database management ->click chuột phải lên database sales vừa tạo -

>chọn move database path 
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Cửa sổ move database path sẽ xuất hiện ->database path và log folder path nhập 

đường dẫn mới cho database sales và log của database sales -> click move 

 

 
 Sau khi click move thì sẽ xuất hiện hộp thoại thông báo để move database 

sales phải ở trạng thái dismount, vấn đề này sẽ ảnh hưởng đến việc truy cập của 

các user đang sở hữu mailbox tại database sales -> yes để đồng ý move.

 
Click finish để hoàn tất quá trình move database sales qua nơi lưu trữ mới. 
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2.4. Cấu hình public folders 

- Kiểm tra trạng thái public folder Sales 

Mở exchange management console ->Toolbox ->public folder management 

console 

 
 Sau khoảng 1 lúc thì phần quản lý public folder sẽ mở ra ->    chuột phải lên 

public folder như trong hình bên dưới ->    connect to server->Click connect 

 
Click browse ->server EX2010 ->connect 
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 Sau khi kết nối ->public folder ->chọn default public folders ->click phải 

lên folder sales như trong hình ->chọn properties 

 
Cửa sổ sales properties sẽ xuất hiện ->tại tab General kiểm tra số lượng size và 

item có trong folder này. Đây là sẽ cơ sở để kiểm tra sau khi replicate thành 

công. 

 
 Để nguyên public folder management console tại đó, trong mục C tiếp theo 

chúng ta sẽ làm tiếp. 

- Tạo public folder database trên server EX2010-2 

Tại EX2010-2 mở exchange management console ->organization configuration 

->mailbox ->click phải chọn new public folder database 
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Cửa sổ new public folder database xuất hiện ->điền tên Pub_On_EX2010_2 

vào ô public folder database name ->click browse chọn server EX2010-2 -> 

click OK 

 
 

Click next ->next ->new ->finish để tạo public folder trên server EX2010-2 

- Tạo đồng bộ cho public folder Sales trên EX2010-2 

Mở lại cửa sổ public folder management console đã mở ở phần a trước đây 

->public folder ->default public folder ->click phải lên sales folder ->chọn 

properties ->chọn tab replication ->click Add 
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Cửa sổ select public folder database xuất hiện ->chọn Pub_On_EX2010_2 

->click OK 2 lần để hoàn tất bước cấu hình replicate. 
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Trong server name click browse chọn server EX2010 ->click next 

  

 
 Sau khi click next thì hệ thống sẽ yêu cầu nhập đường dẫn lưu database 

file và log file, tại đây tôi lưu ở thư mục C:\MailBox ->click next ->click new 

để tiến hành tạo database 

 Quá trình replicate có thể mất một khoảng thời gian phụ thuộc vào số 

lượng item và size trên folder ta thực hiện. 

- Kiểm tra sau khi quá trình replication diễn ra 

 Sau một khoảng thời gian thì quá trình replicate đã diễn ra, để biết được 

cấu trúc folder sales đã được replicate qua public folder mới này ta chưa sẽ phải 

kiểm tra lại một lần nữa. 

 Để kiểm tra tại public folder management console ->chọn public folder -> 

click connect to server ->chọn server EX2010-2.mshome.com ->click OK -> 

click connect 

 Sau khi đã kết nối mở rộng public folder ->default public folder ->click 
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phải lên sales folder ->chọn properties ->tại tab general kiểm tra số lượng size và 

item có đúng với như sales folder trên EX2010 không ? Qua hình ta có thể thấy 

kết quả đúng với như sales folder trên EX2010. (Size = 1, Items = 3) 
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BÀI 7: QUẢN LÝ RECIPIENT 

Mã bài: 19.7 

 

Giới Thiệu 

 Trong bài lab này chúng ta sẽ tiếp tục tìm hiểu và cách quản lý các loại 

mailbox, cấu hình email address policies, tạo address list trong hệ thống của 

mình 

 Mục Đích 

- Quản lý các loại recipient 

- Cấu hình email address policies 

- Cấu hình address lists 

Nội dung chính: 

Hình 7.1: Mô Hình LAB 

 

 
1. Yêu cầu 

Mô hình lab sẽ bao gồm 4 máy: 

o DC2008: đóng vai trò server AD2008 đã được chuyển đổi các role từ 

DC2003 qua 

o EX2010: đóng vai trò server EX2010 trong hệ thống và đã được chuyển đổi 

các mailbox, public folder và system folder từ EX2003 qua. 

o EX2010-2: đóng vai trò server exchange thứ 2 trong hệ thống 

o CLI01: đóng vai trò client trong hệ thống, máy này đã join domain 

2. Quản lý các loại recipient 

• Tạo mới mailbox question 

 Dùng exchange management console ->recipient configuration ->mailbox 
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->click phải chọn new mailbox 

 
Cửa sổ new mailbox wizard sẽ xuất hiện ->chọn user mailbox ->click next 

 
Kiểm tra chắc chắn new user đã được chọn ->click next 

 
 Tại ô name, user logon name nhập question ->nhập mật khẩu vào ô 

password và nhập lại mật khẩu lần nữa vào ô confirm password ->click next 
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Sau khi click next cửa sổ mailbox setting sẽ xuất hiện ->click specify the 

mailbox database rather than…. ->click browse và chọn database trên server 

EX2010 ->click OK. 

 
Tại alias nhập tên question ->click next 

 
Click next ->click next ->click finish để hoàn tất quá trình tạo mailbox cho user 
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question 

• Tạo mới mailbox resource tên phonghop dành cho mục đích đặt phòng 

trước khi họp 

 Dùng exchange management console ->recipient configuration ->mailbox 

->click phải chọn new mailbox ->chọn room mailbox ->click next 

 
Click new user ->click next 

 
Điền thông tin: Name: phonghop 

User logon name: phonghop 

Password: p@ssw0rd 

Click next 
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Tại alias nhập thông tin phonghop ->click chọn specify the mailbox 

database rather than using a database.. ->click browse và chọn database 

mailbox trên server EX2010 ->click OK ->click next 

 
Click next ->click new ->sau đó click finish để hoàn tất quá trình tạo mailbox 

resource phonghop 

Sau khi tạo xong mailbox resource ta phải mở tính năng resource booking 

Tại mailbox chọn mailbox phonghop ->click properties 
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Chọn tab resource general ->chọn enable the resource booking attendant -

>click OK 

 
• Tạo mail-enable contact cho user marketing01 

Tại recipient ->chọn mail contact ->click phải chọn new mail contact 
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Click new contact ->click next -> 

 
Nhập các thông tin như sau: Name: marketing01 

Alias: marketing01 

Click edit ->nhập email address của user marketing01 là  

marketing01@yahoo.com ->click OK->Click next 

 
 Click new ->click finish để hoàn tất quá trình tạo mail contact cho user 

marketing01 

 Note: user marketing01 không phải là nhân viên chính thức của công ty, 

chỉ là partner nên không dùng email chính thức trong công ty. Mọi liên lạc với 

mailto:marketing01@yahoo.com
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nhân viên này đều thông qua email cá nhân của họ. 

• Tạo mới nhóm cho các nhân viên thuộc văn phòng chính tại HCM và gán 

quyền quản lý nhóm cho user Director 

Tạo mới nhóm cho văn phòng HCM, trong nhóm này sẽ chưa các nhân viên 

sales01, sales02, tech01, tech02 và director. 

Tại recipient configuration ->click phải chọn new distribution group 

 
Kiểm tra new group đã được chọn ->click next 

 

 
Sau khi click next khai báo các thông tin sau: Group type: Distribution 

Name: HCM 

Name (pre-windows 2000): HCM 

Alias: HCM 

Click next ->click new ->click finish để hoàn tất quá trình tạo nhóm. Tại 

ngay Distribution Group ->chọn nhóm HCM ->click phải chọn properties 
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Cửa sổ HCM Properties xuất hiện ->chọn tab member ->click add 

 
Nhấn Ctrl và chọn lần lượt các user Director, sales01, sales02, tech01 và tech02 

->click OK 

 
Click Mail Flow Setting tab ->chọn message moderation ->chọn properties 
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Chọn message sent to this group have to be approved by a moderator -

>trong specify group moderators ->click add 

 
Chọn Director ->click OK 2 lần để hoàn tất phần lab này. 

 
• Kiểm tra sau các quá trình tạo bên trên 

- Đăng nhập vào máy CLI01 với user administrator 

- Mở Microsoft Outlook 2007 

- Click New ->Meeting Request 
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- Click To ->click chọn HCM ->click required 

- Tương tự click phonghop ->click resource 

- Click OK  

Nhập các nội dung như hình bên dưới và click send 

 
- Log off CLI01 

- Tại EX2010 mở Internet Explorer https://webmail.mshome.com/owa 

https://webmail.mshome.com/owa
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- Đăng nhập với username mshome\sales01 và password: p@ssw0rd 

 
 Tại đây ta sẽ nhận được một invitation từ user administrator ->nhấp đôi 

chuột lên email với subject hop toan cong ty ->click accept ->send the 

response now. 

 
3. Cấu hình email address policies 

• Tạo email address cho các user thuộc công ty MSHOME 

Tại máy EX2010 mở exchange management console ->organization 

configuration ->hub transport ->click phải chọn new email address policy 
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Trong ô name nhập Format name ->click browse ->chọn OU Users như trong 

hình ->chọn All recipient types ->click next 

 
Chọn recipient is in a company ->click specified ->click next 
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Nhâp mshome ->click add ->click OK 

 

 
Click next ->chọn Add SMTP Address 
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Click chọn first name.last name (john.smith) ->chọn select the accepted 

domain for the e-mail address ->click browse 

 
Chọn mshome.com ->click OK 
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Các bước còn lại để mặc định, click next ->next ->new ->finish để hoàn tất 

quá trình tạo. 

• Kiểm tra lại email address sau quá trình tạo policy 

Tại recipient configuration ->click mailbox ->double click trên user tech01 

->chọn email address tab và xem địa chỉ email hiện tại 

 

 
 

Chọn organization tab và nhập thông tin vào trường Company là MSHOME 

->click Apply 
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 Click lại email address tab và ta sẽ thấy sự thay đổi theo policy mà ta vừa 

tạo ở trên.  

4. Cấu hình address lists 

• Tạo một address list trống để chứa 2 bộ phận Sales Dept và Tech Dept 

Dùng exchange management console ->organization ->mailbox ->chọn tab 

Address List ->click phải chọn New Address List 

 

 
Cửa sổ New Address List xuất hiện và nhập các thông tin sau: Name: 

Companies 

Display Name: Companies Click Next 
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Chọn None ->click Next 

 

 
Click New ->click Finish để hoàn tất quá trình tạo danh sách chứa address list 

của 2 nhóm Sales Dept và Tech Dept 

• Tạo address list cho bộ phận Sales 

 Trước khi tạo address list cho bộ phận Sales ta phải chỉ định cho các user 

sales có thuộc tính thuộc bộ phận Sales 

Dùng exchange management console ->recipient configuration -> mailbox -

>click phải lên user Sales01 chọn Properties ->chọn tab organization và nhập 

Sales vào ô Department ->click OK 

Tương tự như vậy khai báo thông tin cho user Sales02 
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Tại exchange management console ->di chuyển tới organization 

configuration ->mailbox ->chọn tab address list ->click chọn New Address 

List ->cửa sổ New Address List xuất hiện và khai báo các thông số sau: 

Name: Sales Dept 

Display Name: Sales Dept 

Container: click browse và chọn Companies đã tạo ở trên Click Next 

 
Cửa sổ Filter Settings xuất hiện ->chọn All recipient types ->click Next 
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Cửa sổ Conditions xuất hiện ->chọn Recipient is in a Department ->click 

specified 

 
Nhập Sales và click Add ->click OK 

 
Quay lại cửa sổ Conditions ->click Next 

 
Tại cửa sổ Schedule chọn Immediately ->click Next 
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Click New ->click Finish để hoàn tất quá trình tạo address list cho bộ phận 

Sales 

• Tạo address list cho bộ phận Technical 

Tương tự các bước trên tạo address list cho bộ phận Technical 

Thêm thông tin Department cho user Tech01 

 
Tương tự cho user Tech02 



91 

 

91 
 

 
Khai báo thông tin như trong hình bên dưới ->click Next 

 
Chọn All recipient types ->click Next. 

Chọn recipient is in a company ->click Specified và nhập Technical -> 

click Next 

 



92 

 

92 
 

 Các giá trị còn lại để mặc định ->click Next ->Click New ->click finish để 

hoàn tất quá trình tạo address cho bộ phận Technical 

Kiểm tra sau khi tạo address list 

Tại máy CLI01 đăng nhập với user administrator mở Microsoft Outlook 

2007 ->vào menu Tools ->chọn Address Book 

 
Tại cửa sổ Address Book ->click mũi tên trổ xuống ta sẽ thấy có danh sách 

Companies trong này và trong danh sách này sẽ chứa 2 address list là Sales 

Dept và Technical Dept 

 
Chọn address list Sales Dept ta sẽ thấy có 2 user là Sales01 và Sales02 
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Chọn address list Tech Dept ta sẽ thấy có 2 user là Tech01 và Tech02 

• Tạo Offline Address Book cho bộ phận Sales và Technical 

Trong exchange management console ->chọn organization configuration 

->mailbox ->click phải chọn New Offline Address Book 

 
Cửa sổ New Offline Address Book xuất hiện ->nhập Everybody vào ô Name -

>click Browse 

 
Chọn EX2010 ->click OK 

 
Click chọn Include the following address lists ->click Add 
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Cửa sổ Select Address List xuất hiện ->chọn Companies ->click OK ->click 

Next 

 
Tại Distribution Points chọn Enable Web-based distribution và Enable 

public folder distribution ->click Add-

 
Chọn OAB (Default Web Site) ->click OK 
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Click Next ->click New ->click Finish để hoàn tất quá trình tạo Offline 

Address Book 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



96 

 

96 
 

BÀI 8: QUẢN LÝ CLIENT ACCESS ROLE 

Mã bài: 19.8 

 

Giới Thiệu 

 Trong bài lab này chúng tôi sẽ hướng dẫn cách quản lý, cấu hình các dịch 

vụ phục vụ cho mục đích truy cập của người dung cuối. 

Mục Đích 

- Cấu hình Client Access Server 

- Cấu hình Outlook Anywhere 

- Cấu hình Outlook Web App 

- Cấu hình Exchange Activesyns 

Nội dung chính 

Hình 8.1 Mô Hình LAB 

 

 
1. Yêu cầu 

Mô hình lab sẽ bao gồm 4 máy: 

o DC2008: đóng vai trò server AD2008 đã được chuyển đổi các role từ DC2003 

qua 

o EX2010: đóng vai trò server EX2010 trong hệ thống và đã được chuyển đổi các 

mailbox, public folder và system folder từ EX2003 qua. 

o EX2010-2: đóng vai trò server exchange thứ 2 trong hệ thống 

o CLI01: đóng vai trò client trong hệ thống, máy này đã join domain 

2. Cấu hình Client Access Server 

Cài đặt CA server để cung cấp certificate trong hệ thống 

 Trong phần này chúng ta sẽ tiến hành cài đặt server CA trong hệ thống để 

phục vụ cho việc cung cấp và request certificate trong hệ thống. Ta sẽ dùng 

server DC2008 để phục vụ cho việc này. Tại server DC2008 mở Server Role 

->Role ->Add Role ->cửa sổ Add Role Wizard sẽ xuất hiện ->click Next 
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Tại cửa sổ Select Server Roles chọn Active Directory Certificate Services -

>click Next. 

Trong cửa sổ Introduction to AD Certificate Services ->click Next 

 

 
Trong cửa sổ Select Role Services chọn 3 dịch vụ Certification Authority, 

Certification Authority Web Enrollment, Online Responder ->click Next 
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Tại cửa sổ Specify Setup Type chọn Enterprise ->click Next 

 
 

Các thông số còn lại để mặc định cho đến màn hình Confirm Installation 

Selections ->click Install để quá trình cài đặt bắt đầu. 

 
 Sau khi cài đặt xong thì sẽ hiện ra màn hình Installation Results ->click 

Close để đóng màn hình lại. 

 Sau khi đã cài đặt xong CA ta cần enable CA server để cung cấp certificate 

với nhiều Subject Alternative Names 

Click Start ->trong search box gõ CMD ->enter ->và gõ lần lượt các lệnh sau: 

certutil -setreg policy\EditFlags 

+EDITF_ATTRIBUTESUBJECTALTNAME2 
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Tại CMD tiếp tục gõ 2 lệnh sau: net stop certsvc & net start certsvc 

 
.3. Cấu hình External Client Access Domain cho server EX2010-2 

Tại EX2010-2 mở Exchange Management Console ->click Server 

Configuration ->click Client Access ->click phải chọn Configure External 

Client Access Domain 

 
Tại màn hình Configure External Client Access Domain nhập 

mail.mshome.com ->click Add 
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Tại màn hình Select Client Access Server chọn server EX2010-2 ->click OK 

 
Click Configure ->click Yes ->sau đó click Finish 
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Sau khi tạo xong ->click chọn EX2010-2 ->click phải OWA (Default Web 

Site) ->chọn Properties 

 
Tại tab General kiểm tra External URL đã thay đổi thành  

https://mail.mshome.com/owa --> click OK 

 
Chuẩn bị certificate request trên server EX2010-2 
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Trong Exchange Management Console ->click phải EX2010-2 ->chọn New 

Exchange Certificate 

 
Cửa sổ New Exchange Certificate xuất hiện ->nhập MSHOME Mail 

Certificate vào ô Enter a friendly name for the certificate ->click Next 

 
Tại Domain Scope kiểm tra check box Enable wildcard certificate đã được 

bỏ ->click Next 

 
Trong trang Exchange Configuration mở rộng Client Access Server 
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(Outlook Web App) và chọn Outlook Acces App is on the Intranet và 

Outlook Acces App is on the Internet ->kiểm tra mail.mshome.com đã có 

trong ô text thứ 2 

 
Mở rộng Client Access Server (Exchange ActiveSync) ->chọn Exchange 

ActiveSync is enabled 

 
Mở rộng Client Access server (Web Services, Outlook Anywhere, and 

Autodiscover ->nhập mail.mshome.com tại External host name… 

 Kiểm tra Autodiscover used on the Internet và Long URL đã được chọn 

Click Next 
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Tại Certificate Domain ->click Next 

Trong Organization and Location khai báo các thông tin sau: Organization: 

MSHOME 

Organization Unit: Messaging Country/region: Vietnam City/locality: HCM 

State/province: HCM 

Click Browse và chỉ đường dẫn vào thư mục C:\Cert với tên certrequest.req 

Click Next 

 
Click Finish để hoàn tất quá trình chuẩn bị certificate trên server EX2010-2 

 

 
Tạo certificate từ server DC2008 

 Mở My Computer ->vào thư mục C:\Cert ->click lên file certrequest.req 

vừa tạo ở trên ->click phải lên certrequest.req ->chọn Open 
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Chọn Select a program from a list of installed programs ->click OK 

 

Trong màn hình Open with chọn Notepad ->click OK 

 
Trong cửa sổ notepad ->nhấn Ctrl + A để chọn hết ->nhấn Ctrl + C để 

copy toàn bộ vào clipboard ->close notepad 

Dùng Internet Explorer mở trang web request CA  

http://dc2008.mshome.com/certsrv đăng nhập với username Administrator và 

mật khẩu P@ssw0rd 

 
Tại trang Welcome click Request a certificate 

 

http://dc2008.mshome.com/certsrv
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Tại trang Request a Certificate ->click advance certificate request 

 
Tại trang Advance Certificate Request ->click Submit a certificate 

request by using a base-64-encoded CMC or PKCS#10 file, or submit a 

renewal request by using a base-64-encoded CMC or PKCS#7 file 

 

 
Tại trang Submit a Certificate Request or Renewal Request ->click 

Saved Request ->nhấn Ctrl + V để dán đoạn đoạn mã vừa copy trước đó vào. 

Tại Certificate Template ->chọn Web Server ->click Submit ->click Yes 

 
Tại trang Certificate Issued ->click Download certificate chain 
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Trong hộp thoại File Download ->click Save ->trong hộp thoại Save As -

>chỉ tới thư mục C:\Cert ->click Save 

Tại hộp thoại Download Complete ->click Open 

Tại hộp thoại Certificate chọn tab Details ->click Subject Alternative 

Name ->kiểm tra thông tin tại field này chứa nhiều Subject Alternative Names 

->Click OK 

 
Import và assign certificate vào IIS Exchange Service 

Tại Exchange Management Console ->chọn Server Configuration ->Chọn 

server EX2010-2 ->nhìn xuống dưới và click phải lên MSHOME Mail 

Certificate ->chọn Complete Pending Request  
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Tại trang Complete Pending Request ->click Browse 

 
Di chuyển tới thư mục C:\Cert và chọn file certnew đã download trong 

phần trước và click Open 

 
Click Complete và click Finish để hoàn tất quá trình import certificate 

vào server exchange 

 

 

 

 

 

 

 

 

 

Cũng tại màn hình đang làm viêc click phải lên MSHOME Mail 

Certificate chọn Assign Services to Certificate 
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Tại trang Select Servers kiểm tra server EX2010-2 đã hiển thị tại đó ->click 

Next 

 

 
Tại trang Select Services chọn service Internet Information Services ->click 

Next 
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Click Assign và click Finish để hòan tất quá trình import certificate vào IIS tại 

server EX2010-2 

 
4. Cấu hình Outlook Anywhere 

• Cấu hình DNS record mail.mshome.com cho server EX2010-2 

Tại server DC2008 ->click Start ->click Administrative Tools ->click DNS 

 

 
 Trong cửa sổ DNS Manager mở rộng Forward Lookup Zones ->mở 

rộng zone mshome.com ->click phải chọn New Host (A or AAAA) 
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Trong hộp thoại New Host khai báo các thông tin sau: 

Name: mail 

IP address: 192.168.1.114 

Sau đó click Add Host 

Click OK để đóng cửa sổ thông báo ->click Done ->close DNS Manager 

b.Cấu hình Outlook Anywhere trên server EX2010-2 

 Tại server EX2010-2 click Start ->Administrative Tools ->chọn Server 

Manager 

 
Click Features ->trong Features Summary kiểm tra RPC Over HTTP Proxy 

đã được cài đăt. 

 
Tại server EX2010-2 mở Exchange Management Console ->Server 

Configuration ->Client Access ->click phải lên server EX2010-2 ->chọn 
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Enable Outlook Anywhere 

 
 Trong cửa sổ Enable Outlook Anywhere ->nhập mail.mshome.com vào 

ô External host name ->chọn NTLM authentication ->click Enable 

 

 
Trong trang Completion ->click Finish 

Đóng tất cả các cửa sổ lại và restart server EX2010-2 

5. Cấu hình Outlook profile để dung Outlook Anywhere 

 Tại máy CLI01 đăng nhập với user Tech02 ->click Start ->Control 

Panel -> 

click phải Mail chọn Open 

 
Trong cửa sổ Mail Setup ->chọn Email Accounts 
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Trong cửa sổ Email Accounts ->click chọn tech02@mshome.com ->click 

Change

 
Trong trang Microsoft Exchange Settings ->chọn More Settings 

Trong hộp thoại Microsoft Exchange ->chọn Connection tab ->chọn 

Connect to Microsoft Exchange using HTTP ->click Exchange Proxy 

Settings 

Trong Microsoft Exchange Proxy Settings khai báo các thông số sau: 

Use this URL: https://mail.mshome.com Connection using SSL only: enable 

On fast networks: enable 

On slow networks: enable 

Proxy authentication settings: NTLM Authentication 

mailto:tech02@mshome.com
https://mail.mshome.com/
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Click OK 2 lần để đóng cửa sổ Microsoft Exchange lại 

 
Trong cửa sổ Microsoft Exchange Settings ->click Next 

Trong trang Change E-mail Account ->click Finish 

Trong trang E-mail Accounts ->click Close 2 lần để đóng các cửa sổ hiện tại 

lại 

• Kiểm tra kết nối sau khi cấu hình 

 Kiểm tra server EX2010-2 đã boot vào tới màn hình Welcome sau đó 

đăng nhập vào EX2010-2 với username Administrator và mật khẩu 

P@ssw0rd  Tại máy CLI01 mở Office Outlook 2007 ->nếu hộp thoại Outlook 

xuất hiện -> click No 

 Kiểm tra dưới góc phải mà hình đã hiển thị dòng chữ Connect to 

Microsoft Exchange 

 
Sau đó nhấn và giữ phím Ctrl lên icon Office Outlook dưới thanh taskbar 

và click phải chọn Connection Status 

 
Kiểm tra trạng thái kết nối tại cột Conn là HTTPS ->click Close 



115 

 

115 
 

 

 
Sau đó nhấn và giữ phím Ctrl lên icon Office Outlook dưới thanh taskbar 

và click phải chọn Test Email AutoConfiguration. 

 
Trong cửa sổ Test Email AutoConfiguration nhập mật khẩu của user Tech02 

->click Test 

 
Xem thông tin kết quả tại màn hình Results bên dưới 
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Click tab Log để xem quá trình user hoàn thành quá trình Autodiscover 

như thế nào. 

Như vậy là quá trình cấu hình Client Access Server và Outlook 

Anywhere đã thành công. Trong phần tiếp theo chúng ta sẽ tiến hành cấu hình 

Outlook Web App và cấu hình Exchange ActiveSync 

6. Cấu hình Outlook Web App 

• Cấu hình IIS để dùng CA certificate nội bộ 

Tại server EX2010-2 click Start ->Administrative Tools ->Internet 

Information Service (IIS) Manager. 

 
Sau đó mở rộng EX2010-2 ->mở rộng Sites ->Default Web Site ->click 

chọn OWA ->nhấp đôi chuột lên SSL Setting 
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Kiểm tra Require SSL đã được chọn 

 
Bên dưới Sites ->click phải Default Web Site ->chọn Bindings 

 
Trong hộp thoại Site Bindings click chọn https ->click Edit 

 
Trang Edit Site Binding sẽ xuất hiện ->trong hộp thoại SSL certificate -> 

chọn MSHOME Mail Certificate ->click OK ->click close ->sau đó đóng IIS 

lại. 
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• Cấu hình Outlook Web App cho tất cả user 

Tại server EX2010-2 mở Exchange Management Console ->Server 

Configuration ->Client Access ->click chọn EX2010-2 ->nhìn xuống bên 

dưới ta sẽ thấy OWA (Default Web Site) ->click phải lên OWA (Default Web 

Site) chọn Properties. 

Tại owa (Default Web Site) Properties ->chọn tab Authentication kiểm tra 

Use forms-based authentication đã được chọn 

Dưới Logon format chọn User name only ->click Browse chọn 

mshome.com và click OK 

 
Click tab Segmentation ->click Tasks ->chọn Disable ->click Rules ->chọn 
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Disable ->click OK 2 lần. 

 
Mở Exchange Management Shell và gõ lần lượt các câu lệnh bên dưới: 

set-owavirtualdirectory „owa (Default Web Site)‟ –ForceSaveFileTypes .doc 

 
set-owavirtualdirectory „owa (Default Web Site)‟ –GzipLevel Off 

 
Set-OwaVirtualDirectory -identity “Owa (Default Web Site)” - 

FilterWebBeaconsAndHtmlForms ForceFilter 

 
Tiếp tục gõ IISReset /noforce, nếu bạn nhận được thông báo IIS không thể 

start thì dùng trực tiếp IIS Manager để start lại service World Wide Web 

Publishing Service 

 
• Cấu hình Outlook Web App mailbox policy cho các user ngoại trừ user 
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question 

Tại Exchange Management Console ->click Organization 

Configuration -> Client Access ->click phải chọn New Outlook Web App 

Mailbox Policy 

 
Tại New Outlook Web App Mailbox Policy nhập MSHOME Policy ->chọn 

Change Password ->click Disable 

 
Click New ->click Finish để hoàn tất quá trình tạo policy cho Outlook 

Web App service 



121 

 

121 
 

 
Sau khi hoàn tất trở lại màn hình làm việc của Exchange Management 

Console ->click phải MSHOME Policy chọn Properties 

 
Tại tab Public Computer File Acccess bỏ chọn các check box 
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Tại tab Private Computer File Access bỏ chọn các check box ->click OK

 
Tại Exchange Management Console ->chọn Recipient Configuration -> 

chọn Mailbox ->nhấn giữ phím Ctrl và click phải lên các user Administrator, 

Director, Sales01, Sales02, Tech01 và Tech01 ->chọn Properties 

 
Chọn tab Mailbox Features ->chọn Outlook Web App ->chọn Properties 

 
Tại hộp thoại Outlook Web App Properties ->click chọn Outlook Web App 

mailbox policy ->click Browse. 
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Chọn MSHOME Policy ->click OK 4 lần 

 
• Kiểm tra sau khi cấu hình Outlook Web App 

Tại máy EX2010 ->mở Internet Explorer ->truy cập trang web  

https://mail.mshome.com/owa 

Đăng nhập với user Question và mật khẩu p@ssw0rd ->click Sign in 

 
Kiểm tra Tasks Folder không hiển thị trong webmail của user Question 

 

https://mail.mshome.com/owa
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Trong Outlook Web App click Options ->kiểm tra user Question không 

thể tạo rule thông qua webmail 

 
 

Tại webmail click Sign out ->đăng nhập với user Tech01 

 

 
 

Ta thấy Tasks Folder vẫn hiển thị trong webmail của user Tech01 

Trong webmail click Options ->click Settings và kiểm tra là user Tech01 

không có lựa chọn thay đổi mật khẩu 
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7. Cấu hình Exchange ActiveSync 

• Disable SSL cho Exchange ActiveSync 

Tại EX2010-2 click start ->Administrative Tools ->click chọn Internet 

Information Services (IIS) Manager. 

 
Mở rộng EX2010-2 ->Sites ->Default Web Site ->Microsoft–Server- 

ActiveSync ->click SSL Settings 

 
Bỏ chọn Require SSL ->click Apply 

 
Kiểm tra cấu hình Virtual Directory của Exchange ActiveSync 

Tại EX2010-2 click Exchange Management Console ->Server 

Configuration ->Client Access ->chọn EX2010-2 ->click phải Microsoft- 
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Server-ActiveSync chọn Properties 

 
Chọn tab Authentication ->kiểm tra check box Basic authentication đã 

được chọn ->click OK 

 
Kết nối tới server dùng Exchange ActiveSync 

Tại máy CLI01 đăng nhập với tài khoản Administrator và mật khẩu 

P@ssw0rd 

Click Start ->All Programs ->click Windows Mobile 6 SDK ->Standalone 

Emulator Images ->US English ->WM 6.1.4 Professional 

Chờ cho chương trình ảo hóa mobile trên PC khởi động sau đó click File -> 

Configure 
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Chọn tab Network ->chọn Enable NE2000 PCMIA network adapter 

and bind->click OK 

 
Trong Windows Mobile 6 Professional ->click Start ->Settings 

Click tab Connection ->double click lên icon Network Cards 

Trong Configure Network Adapters phần My network card connects to: 

chọn The Internet ->sau đó click chọn NE2000 Compatible Ethernet Driver 

 
Click chọn Use specify IP address và khai báo các thông tin sau: IP address: 
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192.168.1.115 

Subnet mask: 255.255.255.0 

Default gateway: 192.168.1.1 

 
Chọn tab Name Servers và khai báo IP server DNS vào ô DNS: 192.168.1.112 

Click OK 2 lần và đóng trang cấu hình lại. 

 
Trong Windows Mobile 6 Professional click start ->Programs 
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Click ActiveSync 

 
Trong cửa sổ ActiveSync ->click set up your device to sync with it 
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Trong Email address nhập tech01@mshome.com ->click Next 

 
Tại màn hình User Information khai báo các thông số sau: Username: tech01 

Password: P@ssw0rd 

Domain: mshome 

Sau khi khai báo xong thông tin click Next để chuyển qua bước tiếp theo 

 
Tại Edit Server Settings ->nhập ex2010-2.mshome.com vào ô Server 

address và bỏ chọn This server requires an encrypted (SSL) connection 

mailto:tech01@mshome.com


131 

 

131 
 

 
Một cửa sổ thông báo nhỏ sẽ xuất hiện ->click OK ->click Next 

 
Tại phần Choose the data you want to synchronize ->click chọn Calendar -> 

click Settings 

 
Dưới phần Synchronize only the past ->chọn All ->click OK 
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Trở lại trang Choose the data you want to synchronize ->click chọn Email -> 

click Settings 

 
Trong phần Download the past ->chọn All ->click OK 

 
Kiểm tra Contacts, Calendar, E-mail, và Tasks đã được chọn ->click Finish 

 
Trong ActiveSync click OK ->sau khi sync xong click dấu X trên góc phải 

đóng cửa sổ hiện tại lại. 

Tại máy CLI01 mở Internet Explorer và đăng nhập với user Tech02 ->tạo 

một mail mới và gửi cho user Tech01 
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Quay lại màn hình giả lập Windows Mobile 6 Professional ta sẽ thấy 

thông báo có mail mới 

Click Outlook Email ->ta sẽ thấy email mà user Tech02 gửi tới 

 
Click Reply để trả lời email cho user Tech02 ->nhập nội dung Test reply from 

tech01 và click Send 

 
Qua webmail của user Tech02 thì ta thấy sẽ nhận được email từ Tech01 trả lời.
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Tạo policy cho Exchange ActiveSync 

Tại Exchange Management Console ->click Organization Configuration -> 

click Client Access ->click phải vào vùng làm việc giữa màn hình chọn New 

Exchange ActiveSync Mailbox policy 

 
Trong New Exchange ActiveSync Mailbox Policy nhập EAS Policy 1 vào ô 

Mailbox policy name 

Chọn Allow non-provisionable devices và Allow attachments to be 

downloaded to device 

Dưới mục Require password chọn Enable password recovery 

Click New để tạo Exchange ActiveSync Mailbox Policy 
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Kiểm tra lại thông tin và click Finish 

 
Sau khi đã tạo xong tại ngoài màn hình làm việc click phải lên EAS Policy 1 

chọn Properties 

 
Kiểm tra các tab giống như cấu hình trong các hình bên dưới 

Tab General 
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Tab Password 

 
Tab Device 

 
 

Tab Other 
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Click OK để đóng cửa trang EAS Policy 1 Properties 

Trong Exchange Management Console ->chọn Recipient Configuration -> 

Mailbox ->click phải lên user Tech01 chọn Properties 

 
Chọn tab Mailbox Features ->chọn Exchange ActiveSync ->click 

Properties 
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Trong Exchange ActiveSync Properties ->click Browse chọn EAS Policy 1 

->click OK 2 lần để apply thông tin thay đổi. 

 
b. Kiểm tra Exchange ActiveSync policy 

Tại CLI01 trong Windows Mobile 6 Professional ->click Start ->ActiveSync 

 
Click Sync 

Cửa sổ Update Required xuất hiện ->click OK 
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Trong Password và Confirm Password nhập 12345 ->click OK 

 
Cài đặt Root CA trên mobile 

Tại CLI01 mở Internet Explorer truy cập trang web  

http://dc2008.mshome.com/certsrv 

Trong trang Welcome ->click Download a CA certificate, certificate 

change, or CRL 

 
Tại trang Download a CA certificate, certificate change, or CRL click 

Download CA certificate chain. 

http://dc2008.mshome.com/certsrv
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Trong hộp thoại File Download ->click Save 

 
Trong hộp thoại Save As ->click Save 

 
Sau đó đăng nhập với user Administrator và gửi certificate này cho user 

Tech01 .Trên thiết bị mobile của user Tech01 sẽ nhận thông báo có mail mới 
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Mở mail của Administrator gửi và double click lên file certificate để download 

về máy. Trong hộp thoại Certificate Installer ->click OK 

  
Vào menu Start ->Administrative Tools ->Internet Information 

Services (IIS) Manager ->mở rộng Sites ->Default Web Site ->Microsoft-

Server- ActiveSync ->double click lên SSL Settings 

 
Chọn Require SSL ->click Apply 
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Tại màn hình Outlook Email của Windows Mobile 6 Professional ->click 

Menu ->click Tools ->Options 
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Click Outlook Email 

 

 
Click chọn The server requires an encrypted (SSL) connection 
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Click Next 2 lần sau đó click Finish 

 

 
Cick Menu ->click Send/Receive kiểm tra quá trình sync diễn ra với SSL 

thành công. 

c. Xóa dữ liệu trên mobile từ xa thong qua Exchange Control Panel 

Từ máy EX2010 ->mở Internet Explorer truy cập trang web  
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https://ex2010.mshome.com/ecp đăng nhập với user Tech01 ->click Phone ta 

sẽ thấy thiết bị PocketPC hiển thị trong phần Device 

 
Tại Exchange Management Console ->Recipient Configuration ->Mailbox 

->click phải lên user Tech01 chọn Manage Mobile Phone 

 
Trong Manage Mobile Phone chọn Perform a remote wipe to clear mobile 

phone data ->click Clear 

 
Tại cửa sổ cảnh báo của Microsoft Exchange click Yes 

https://ex2010.mshome.com/ecp
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Sau đó click Finish 

 
Tại Windows Mobile 6 Professional tiến hành sync trở lại thông qua 

ActiveSync thì sẽ tiến hành thực thi xóa data trên mobile ->sau khi xóa data 

xong thì máy sẽ yêu cầu reboot lại. 

Vào kiểm tra lại email trên thiết bị mobile thì data đã xóa hoàn toàn. 
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BÀI 9: QUẢN LÝ MESSAGE TRANSPORT 

Mã bài : 19.9 

Giới Thiệu 

Trong bài lab này chúng tôi sẽ giúp các bạn tìm hiểu cách thức vận chuyển 

email trong Exchange 2010. Hiểu được các component đảm nhiệm trách nhiệm 

vận chuyển email trong Exchange 2010. Triển khai các component này để hệ 

thống gửi và nhận email xuyên suốt. 

Mục Đích 

- Cấu hình Send Connector để gửi email 

- Cấu hình Receive Connector để nhận email 

- Mở tính năng Anti-Spam trên Hub Transport server 

- Kiểm tra sau khi cấu hình 

Hình 9.1: Mô hình LAB 

 

 
4. Yêu cầu 

Mô hình lab sẽ bao gồm 3 máy: 

o DC2008: đóng vai trò server AD2008 đã được chuyển đổi các role từ DC2003 

qua 

o EX2010: đóng vai trò server EX2010 trong hệ thống và đã được chuyển đổi 

các mailbox, public folder và system folder từ EX2003 qua. 

o CLI01: đóng vai trò client trong hệ thống, máy này đã join domain 

5. Cấu hình Send Connector 

Xem lại phần cấu hình Send Connector trong mục V.3.b tại bài lab số 2 

6. Cấu hình Receive Connector 

Tại server EX2010 mở Exchange Management Console ->Server 

Configuration ->Hub Transport ->chọn server EX2010 ->di chuyển mouse 

xuống dưới và click phải chọn New Receive Connector 
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Cửa sổ New Receive Connector xuất hiện ->tại trang Introduction khai báo 

các thông số sau: 

Name: Internet Receive Connector 

Select the intended use for this Receive connector: Custom->Click Next 

 
Tại trang Local Network Settings ->click Next 

 
Tại trang Remote Network Settings click dấu X đỏ để xóa entry hiện tại ->sau 

đó click Add 
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Tại hộp thoại Add IP Addresses of Remote Servers ->nhập range IP 

192.168.1.0/24 ->click OK 

 
Click Next ->click New sau đó click Finish để hoàn tất bước tạo mới Receive 

Connector 
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Sau khi tạo xong Receive connector ta tiến hành cấu hình receive connector 

->tại exchange management console ->click phải Internet Receive 

Connector ->chọn Properties 

 
Tại tab General phần Protocol logging level chọn Verbose 

 
Click chọn tab Permission Groups ->chọn Anonymous Users ->click OK 
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Mở tính năng Anti-Spam trên Hub Transport server 

Tại exchange management console ->chọn Server Configuration ->Hub 

Transport ->click chọn EX2010 ->tại bên dưới ta kiểm tra chỉ có duy nhất tab 

Receive Connector 

 
Tại server EX2010 mở exchange management shell và chuyển đến thư mục 

cd “c:\Program Files\Microsoft\Exchange Server\v14\scripts” 
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Tại màn hình command line nhập .\install-AntispamAgents.ps1 ->nhấn 

Enter 

 
Tiếp tục gõ Restart-Service MSExchangeTransport ->nhấn Enter 

 
Tại exchange management console ->Server Configuration ->Hub 

Transport ->click phải chọn Refresh ->click chọn server EX2010 ->kiểm tra 

lại ta sẽ thấy hiển thị tab Anti-Spam 

 
Kiểm tra sau khi cấu hình 

Tại máy CLI01 ->mở Internet Explorer truy cập web  

https://webmail.mshome.com/owa --> đăng nhập với user mshome\sales01 và 

https://webmail.mshome.com/owa
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mật khẩu P@ssw0rd ->gửi một email tới địa chỉ info@internet.com với tiêu đề 

―Test mail to internet” 

Sau đó tại máy EX2010 mở exchange management console ->Toolbox -> 

double click Queue Viewer 

 

 
Tại Queue Viewer ->chọn tab Queues và kiểm tra Message Count thấy có 1 

message 

 
Quay trở lại máy DC2008 ->click Start ->trong hộp tìm kiếm gõ CMD -

>Enter 

Tại CMD nhập telnet ex2010 smtp ->nhấn Enter 

mailto:info@internet.com
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Tại màn hình CMD sau khi telnet vào gõ tiếp các lệnh sau: 

helo ->nhấn enter 

mail from:info@internet.com ->enter rcpt to:WeiYu@adatum.com ->enter 

data ->enter 

Subject: Test from Internet ->enter 

Nhập nội dung test from internet ->enter và sẽ nhận được thông báo 

message rejected as spam by Content Filtering 

 

 
 

Như vậy là ta đã cấu hình xong phần gửi và nhận mail trên exchange 2010. 

Bên cạnh phần gửi và nhận mail thì ta cũng đã mở thêm tính năng ngăn chặn 

spam mail trên exchange 2010. Tuy nhiên để triển khai sâu hơn về hệ thống 

ngăn chặn spam ta hãy xem qua bài lab tiếp theo. 

 

 

 

 

 

 

 

 

 

 

 

mailto:info@internet.com
mailto:WeiYu@adatum.com
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BÀI 10  

TRIỂN KHAI MESSAGING SECURITY 

Giới Thiệu 

Trong bài lab này chúng tôi sẽ hướng dẫn các bạn cách thức quản lý và cấu 

hình một Edge Transport server. Thực thi và cấu hình các cơ chế bảo mật trong 

hệ thống của mình 

Mục Đích 

- Cấu hình Edge Transport server 

- Cấu hình Forefront Protection 2010 cho Exchange Server 2010 

- Triển khai giải pháp chống spam trên Edge Transport server 

Hình 10.1: Mô hình LAB 

 

 
1. Yêu cầu 

Mô hình lab sẽ bao gồm 3 máy: 

- DC2008: đóng vai trò server AD2008 đã được chuyển đổi các role từ 

DC2003 qua 

- EX2010: đóng vai trò server EX2010 trong hệ thống và đã được chuyển đổi 

các mailbox, public folder và system folder từ EX2003 qua. 

- SVR1: đóng vai trò server Edge Transport trong hệ thống 

2. Cấu hình Edge Transport server 

Cài đặt Edge Transport server role trên server SVR1 

Tại server SVR1 ->mở CMD ->chuyển tới thư mục chứa source exchange 2010 

và gõ Setup /mode:install /role:EdgeTransport 
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Sau khi cài đặt xong gõ Exit để tắt CMD và restart lại server SVR1 

Sau khi restart lại server thì đăng nhập vào với tài khoản Administrator 

và mật khẩu P@ssw0rd. 

Tại server SVR1 ->click start ->All Programs ->Microsoft Exchange 

Server 2010 ->Exchange Management Console 

Trong Exchange Management Console quan sát bên trái ta sẽ thấy có 

component Edge Transport như trong hình bên dưới 

 

 
Cấu hình Edge Transport Synchronization 

Tại server SVR1 ->mở Exchange Management Shell và gõ lệnh sau: 
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New-EdgeSubscription -FileName “c:\mshome-svr1.xml” 

Nhấn Enter ->tại màn hình Confirm ->nhập Y ->nhấn Enter 

 
Click menu Start ->trong hộp thoại tìm kiếm gõ \\EX2010\c$ 

 

 

file://EX2010/c$
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Sau đó copy file mshome-svr1.xml từ ổ C: của máy SVR1 qua ổ C: trên máy 

EX2010 

 
 

Qua máy EX2010 mở Exchange Management Console ->Organization 

Configuration ->Hub Transport ->click chọn tab Edge Subscription ->click 

phải chọn New Edge Subscription 
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Tại trang New Edge Subscription trong mục Active Directory Site ->click 

Browse 

 
Trong cửa sổ Select Active Directory Site ->click chọn Default First Site 

Name ->click OK  

 

Bên dưới Subscription file ->click Browse và chỉ đến file mshome-

svr1.xml 

trong ổ đĩa C: ->click Open 
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Sau đó click New 

 
Tại trang Completion ->click Finish 
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Kiểm tra EdgeSync đã hoạt động và Active Directory Lightweight Directory 

Services có chứa thông tin của AD 

Tại server EX2010 ->click Start ->All Programs ->Microsoft Exchange 

Server 2010 ->Exchange Management Shell 

Tại Exchange Management Shell gõ lệnh Start-EdgeSynchronization -

>Enter 

 
Tại Exchange Management Shell tiếp tục gõ Test-EdgeSynchronization -> 

Enter 

 
Tại command promt gõ tiếp Get-User -Identity sales01 | ft Name, GUID 

 
Ghi lại 8 ký tự đầu tiên trong cột GUID để bắt đầu kiểm tra. Chuyển tới 

server SVR1 ->mở CMD và gõ LDP ->Enter 
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Trong cửa sổ LDP ->click Connection ->click Connect 

 
Trong cửa sổ Connect khai báo các thông số sau: 

Server: svr1 

Port: 50389 

Click OK 

 
Click Connection ->click Bind 

Trong cửa sổ Bind ->click chọn Bind as currently logged on user ->click OK 

 
Trong của sổ LDP ->click chọn View ->Tree 



163 

 

163 
 

 
Trong cửa sổ Tree View xóa hết các entry trong phần BaseDN ->click OK 

 
 

Trong cửa sổ LDP double click OU=MSExchangeGateway để mở rộng ra 

 
Double click CN=Recipients,OU=MSExchangeGateway để mở rộng mục 

này. 

Tại đây ta tìm phần CN=[GUID], GUID ở đây là 8 ký tự mà ta đã lấy được tại 

Exchange Management Shell trên server EX2010 lúc nãy. 

lên recipient mà ta tìm được và quan sát thông tin của recipient này. Ta thấy đã 

lấy được thông tin từ hệ thống AD. 

Close LDP 
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Kiểm tra quá trình gửi mail vẫn hoạt động bình thường sau khi cấu hình 

Edge Transport 

Tại server EX2010 ->mở Exchange Management Console ->Organization 

Configuration ->Hub Transport ->click chọn tab Send Connectors -> 

double click EdgeSync - Default-First-Site-Name to Internet 

 
Chọn tab Network và chọn Route mail through the following smart hosts -> 

click Add 
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Trong cửa sổ Add smart host ->click chọn IP address ->nhập IP của 

Edge Transport server 192.168.1.115 ->click OK 2 lần 

 
Mở Exchange Management Shell gõ Start-EdgeSynchronization ->Enter 

 
Mở Internet Explorer và đăng nhập với tài khoản mshome\sales01 và mật 

khẩu P@ssw0rd ->tiến hành gửi một email tới địa chỉ info@internet.com với 

tiêu đề ―test gui mail ra ngoai internet‖ ->click Send 

 

mailto:info@internet.com
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Chờ một lúc và kiểm tra trong Inbox của user sales01 chắc chắn rằng 

không nhận được email thông báo non-delivery report message 

3. Cấu hình Forefront Protection 2010 cho server EX2010 

Cài đặt Forefront® Protection 2010 for Exchange Server 

Tại server SVR1 double click lên file cài đặt forefrontexchangesetup.exe 

Tại trang License Agreement ->click chọn I agree to the terms of the license 

agreement and privacy statement ->click Next 

 
Trong cửa sổ Service Restart ->click Next 

 
Tại cửa sổ Installation Folders ->click Next 

 



167 

 

167 
 

 
Trong trang Proxy Information ->click Next 

 
Tại trang Antispam Configuration ->click Enable antispam later ->click 

Next 

 

 
Trong trang Microsoft Update ->click chọn I don‟t want to use Microsoft 
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Update ->click Next 

 
Trong trang Customer Experience Improvement Program ->click Next 

 
Tại cửa sổ Confirm Settings ->click Next và chờ cho quá trình cài đặt bắt đầu. 

Quá trình cài đặt có thể diễn ra trong vòng 5 phút. 
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Tại cửa sổ Installation Results ->click Finish 

7. Cấu hình Forefront Protection 2010 for Exchange Server 

Tại server SVR1 ->click Start ->All Programs ->Microsoft Forefront 

Server Protection ->click Forefront Protection for Exchange Server 

Console. 

Tại cửa sổ Evaluation License Notice ->click OK 

 
Trong cửa sổ Forefront Protection 2010 for Exchange Server 

Administrator Console ->click chọn Policy Management ->dưới 

Antimalware ->click  Edge Transport 

Trong trang Antimalware - Edge Transport ->dưới phần Engines and 

Performance ->click chọn Scan with all engines 

Trong phần Scan Actions chọn Delete trong phần Action đối với mục 

Virus Tại trang Antimalware - Edge Transport Click Save 

 

 
Tại trang Policy Management mở rộng Global Settings ->click 

Advanced Options.Trong trang Global Settings - Advanced Options ->phần 

Threshold Levels chỉnh sửa các giá trị cho các tham số sau: 

Maximum nested depth compressed files: 10 
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Maximum nested attachments: 50 

 
Dưới phần Intelligent Engine Management chọn Manual trong hộp lựa 

chọn Engine management 

 
Trong bảng Update scheduling ->click Norman Virus Control ->sau đó click 

Edit Selected Engines 

 
Trong hộp thoại Edit Selected Engine phần Update frequently chọn 

Daily -> kiểm tra mục Check for updates every đã được chọn ->nhập 01:00 

trong trong mục bên dưới ->click Apply and Close. 



171 

 

171 
 

 
Tại trang Global Settings - Advanced Options click save 

 
8. Triển khai giải pháp chống spam trên Edge Transport server 

Cấu hình DNS cho việc vận chuyển email 

Tại server DC2008 click Start ->Administrative Tools ->click DNS. 

Tại DNS Manager mở rộng Forward Lookup Zones ->mở rộng domain 

mshome.com ->di chuyển qua vùng giữa màn hình click phải mouse chọn New 

Mail Exchanger (MX) 
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Tại cửa sổ New Resource Record nhập SVR1.mshome.com trong mục 

Fully qualified domain name (FQDN) of mail server 

Click OK và nhấn nút X trên góc phải để đóng DNS Manager 

 
Cấu hình global SCL cho việc vận chuyển junk mail 

Tại server SVR1 mở Exchange Management Console ->Edge Transport -

>click chọn server SVR1 chọn tab Anti-spam ở bên dưới ->double click lên 

mục Content Filtering 

 
Trong cửa sổ Content Filtering Properties chọn tab Action ->bỏ chọn 

Reject messages that have an SCL rating greater than or equal to và click 

OK 

 
Tại server EX2010 mở Exchange Management Shell ->tại Exchange 

Management Shell gõ lệnh Set-OrganizationConfig -SCLJunkThreshold 6 
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và nhấn Enter 

 
 

Sau đó đăng nhập vào user sales02 và gửi một email cho user sales01 với 

nội dung      XJS*C4JDBQADN1.NSBN3*2IDNEN*GTUBE-STANDARD-

ANTI-UBE- TEST-EMAIL*C.34X 

Sau khi gửi xong email thì logout và đăng nhập vào mailbox của user 

sales01 

thì ta sẽ thấy email của user sales02 vừa gửi bị liệt vào hộp Junk E-Mail 

 

Cấu hình Content Filtering để từ chối junk messages 

Tại server SVR1 mở Exchange Management Console ->Edge 

Transport ->click chọn server SVR1 chọn tab Anti-spam ở bên dưới -

>double click lên mục Content Filtering 

 
Trong cửa sổ Content Filtering Properties chọn tab Action ->chọn  

Reject messages that have an SCL rating greater than or equal to và cấu 

hình cho mục này là 7 ->click OK 
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Sau đó đăng nhập vào user sales02 và gửi một email cho user sales01 với 

nội dung XJS*C4JDBQADN1.NSBN3*2IDNEN*GTUBE-STANDARD-ANTI-

UBE- TEST-EMAIL*C.34X 

Sau khi gửi xong email thì logout và đăng nhập vào mailbox của user 

sales01 thì ta sẽ không thấy email của user sales02 vừa gửi bởi vì email này đã 

bị reject trong quá trình kiểm tra chống spam. 

Cấu hình IP Allow List 

Tại server SVR1 mở Exchange Management Console ->Edge Transport -

>click chọn server SVR1 chọn tab Anti-spam ở bên dưới ->double click lên 

mục IP Allow List 

 
Trong cửa sổ IP Allow List Properties ->click chọn tab Allowed Addresses -

>click Add ->trong cửa sổ Add Allowed IP Address nhập 192.168.1.0/24 -

>click OK 2 lần 
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Cấu hình Block List Provider 

Tại server SVR1 mở Exchange Management Console ->Edge Transport -

>click chọn server SVR1 chọn tab Anti-spam ở bên dưới ->double click lên 

mục IP Block List Providers 

 
Trong cửa sổ IP Block List Properties chọn tab Providers ->click Add 

 
Tại cửa sổ Add IP Block List Provider khai báo các thong số sau: 

Provider name: Spamhaus 

Lookup domain: zen.spamhaus.org Click Ok 2 lần 

Đến đây ta đã hoàn tất cấu hình các giải pháp chống spam mail cho hệ 

thống của doanh nghiệp chúng ta. 
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BÀI 11: TRIỂN KHAI BACKUP VÀ  RECOVERY 

Mã bài : 19.11 

 

Giới Thiệu 

Trong bài lab này chúng tôi sẽ hướng dẫn các bạn cách thức sử dụng tính 

năng backup và phục hồi trong Exchange Server 2010 khi xảy ra sự cố. 

Mục tiêu 

- Backup Exchange Server 2010 

- Phục hồi data của Exchange Server 2010 

- Phục hồi Exchange Server 2010 

Hình 11.1:Mô hình LAB 

 

 
1. Yêu cầu 

Mô hình lab sẽ bao gồm 3 máy: 

- DC2008: đóng vai trò server AD2008 đã được chuyển đổi các role từ 

DC2003 qua 

- EX2010: đóng vai trò server EX2010 trong hệ thống và đã được chuyển đổi 

các mailbox, public folder và system folder từ EX2003 qua. 

- SVR1: đóng vai trò standard alone server và sẽ dùng để phục hồi exchange 

server 2010 
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2. Backup Exchange Server 2010 

Gửi một email trước khi tiến hành backup 

Tại máy EX2010 mở Internet Explorer và đăng nhập với tài khoản 

mshome\tech01 sau đó gửi một email cho nhóm Tech với các thông tin bên 

dưới: 

To: tech@mshome.com Subject: test truoc khi backup Body: test truoc khi 

backup Click Send 

 
 

Sau đó tại mailbox của user tech01 ta sẽ nhận được chính email của user 

tech01 vừa gửi 

 
Tại chính server EX2010 mở EMS và gõ lệnh sau Restart-Service 

MSExchangeIS 

 
Tiến hành backup exchange server 2010 

Tại server EX2010 mở Server Manager ->click Features ->Add Features 

mailto:tech@mshome.com
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Trong cửa sổ Add Features Wizard mở rộng Windows Server Backup 

Features chọn Windows Server Backup và click Next 

 
Trong hộp thoại Confirm Installation Selections click Install 

 
Tại màn hình Installation Results xem qua thông tin và click Close 
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Click Start ->click All Programs ->click Administrative Tools ->click 

Windows Server Backup 

 
Tại Windows Server Backup click Backup Once 
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Trong Backup Once Wizard trong trang Backup Options chọn Different 

Options và click Next 

 
Tại trang Select Backup Configuration chọn Custom và click Next 

 
Tại trang Select Items for Backup click Add Items 

 
Trong hộp thoại Select Items chọn mục Local disk (C: ) ->click OK 

 
Tại trang Select Items for Backup click Advanced Settings 
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Tại Advanced Settings chọn tab VSS Settings ->chọn VSS full Backup -> 

click OK ->sau đó click Next 

 

 
Tại trang Specify Destination Type chọn Remote shared folder và click Next 

 
Tại trang Specify Remote Folder trong phần Location điền 
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\\DC2008\c$\Backup ->click Next 

Tại trang Confirmation click Backup 

 

 
Sau khi click Backup thì quá trình backup sẽ diễn ra và ta có thể click Close để 

đóng cửa sổ Backup Progress lại vì quá trình này sẽ chạy ngầm trên server 

 

 
Xóa email sau khi đã tiến hành backup 

Tại server EX2010 mở Internet Explorer và truy cập website  

https://webmail.mshome.com/owa. Đăng nhập với tài khoản mshome\tech02 

file://DC2008/c$/Backup
https://webmail.mshome.com/owa
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và xóa email mà user Tech01 đã gửi trước đó. Chọn email test truoc khi 

backup và click dấu X bên trên để xóa email này. 

Mailbox của user Tech02 trước khi xóa email 

 

 
Mailbox của user Tech02 sau khi xóa email: 

 

 
Di chuyển sang bên trái click phải lên Deleted Items và chọn Empty Deleted 

Items 

 
Hộp thoại Empty Deleted Items xuất hiện chọn Yes 
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Từ webmail logout khỏi user Tech02 và logon với user Tech01, tương tự 

delete email trong Inbox, Send Items và Deleted Items 
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3. Phục hồi data của Exchange Server 2010 

a. Restore database bằng Windows Backup 

Từ server EX2010 mở Windows Server Backup ->click Recover 

 

 
Trong Recovery Wizard tại trang Getting Started chọn This Server 

(EX2010) ->click Next 

 
Tại trang Select Backup Date click Next 
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Tại trang Select Recovery Type chọn Applications và click Next 

 
Tại trang Select Application ->click chọn Exchange sau đó click Next 

 
Tại trang Specify Recovery Options chọn Recover to another location 

và click Browse 
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Tại cửa sổ Browse For Folder mở rộng Computer ->Local Disk (C:) ->click 

Make New Folder tạo mới folder DBBackup tại ổ C: ->click OK 

 
Quay trở lại trang Specify Recovery Options click Next 

 
Tại trang Confirmation click Recover 
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Tại trang Recovery Progress click Close để đóng lại. 

 
b. Tạo recovery database từ file backup 

Tại server EX2010 mở EMS và gõ lệnh sau: 

New-MailboxDatabase -Name “RecoverDB” -Server EX2010 -

EDBFilePath “C:\DBBackup\C_\Program    Files\Microsoft\Exchange 

Server\V14\Mailbox\Mailbox Database 0069891456\Mailbox Database 

0069891456.edb” -Logfolderpath “C:\DBBackup\C_\Program 

Files\Microsoft\Exchange Server\V14\Mailbox\Mailbox Database 

0069891456”-Recovery 

 
Tại EMS tiếp tục gõ lệnh 

cd “C:\DBBackup\C_\Program Files\Microsoft\Exchange 

Server\V14\Mailbox\Mailbox Database 0069891456” 

 
Sau đó tại EMS gõ lệnh eseutil /R E02 /i /d 

Nếu gặp thông báo lỗi thì ta gõ tiếp lệnh bên dưới: 

eseutil /r E01 /l "C:\DBBackup\C_\Program Files\Microsoft\Exchange 

Server\V14\Mailbox\Mailbox Database 0069891456" /d 

"C:\DBBackup\C_\Program    Files\Microsoft\Exchange 

Server\V14\Mailbox\Mailbox Database 0069891456" /a 
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Để mount database vừa phục hồi lên thì ta dùng lệnh Mount-Database 

“RecoverDB” 

 
 

Gõ lệnh Get-MailboxStatistics -Database “RecoverDB” để xem trạng thái 

của database vừa mount lên 

 

 

 

 

 

 

c. Phục hồi một mailbox từ recovery database 

Để phục hồi mailbox cho user Tech01 thì ta dùng lệnh sau 

Restore-Mailbox -Identity tech01 -RecoveryDatabase RecoverDB – 

BadItemLimit 1000 

Tại hộp thoại Confirm nhập A và enter 

 
Sau đó ta đăng nhập webmail với tài khoản mshome\tech01 thì ta thấy lại 

email mà ta đã xóa trước đó. 



190 

 

190 
 

 
Double click lên tiêu đề email và kiểm tra lại nội dung email 

 
Để remove database vừa recover ra khỏi hệ thống tại EMS ta gõ lệnh Remove- 

Mailboxdatabase -Identity RecoverDB 

Tại hộp thoại Confirm trả lời Y và nhấn Enter 

 

 
4. Phục hồi Exchange Server 2010 

a. Shutdown server EX2010 và reset computer account. 

Tại server EX2010 ta tiến hành shutdown server này. Sau đó chuyển qua server 

DC2008 mở Active Directory Users and Computers ->click mở rộng 

mshome.com ->Computers ->click phải lên server EX2010 chọn Reset 

Account 



191 

 

191 
 

 
Trong hộp thoại confirm click Yes-> Sau đó click OK 

Đóng Active Directory Users and Computers lại 

b. Chuẩn bị server SVR1 như server EX2010 

Đăng nhập vào server SVR1 với tài khoản administrator ->click Start ->click 

phải lên My Computer chọn Properties 

Trong cửa sổ System Properties tại tab Computer Name click Change 

 
Trong cửa sổ Computer Name/Domain Changes nhập EX2010 trong ô 

Computer name sau đó click OK 

 

 
Sau khi click OK ->click Close thì hệ thống sẽ yêu cầu restart lại máy 

click Restart Now để restart lại máy 

Sau khi server SVR1 khởi động lại đăng nhập vào với tài khoản 

administrator 

->click Start ->click phải lên My Computer chọn Properties 
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Tại tab Computer Name click Change, dưới Member Of chọn Domain 

và nhập mshome.com ->click OK 
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Cửa sổ Windows Security xuất hiện nhập thông tin tài khoản administrator 

và click OK 

 
Hộp thoại Welcome xuất hiện click OK 2 lần 

 

 
Tại cửa sổ System Properties click OK ->click Close ->click Restart Now để 

restart lại server SVR1 

c. Cài đặt exchange server 2010 dưới dạng RecoverServer 

Tới đây server SVR1 đã được đổi tên thành EX2010 ->đăng nhập vào server 

EX2010 với tài khoản administrator và cài đặt các component cần chuẩn bị 

trước khi cài đặt server một server exchange 2010. Phần này xem lại bài lab số 

2. Tại server EX2010 mở CMD và chuyển tới thư mục chứa source exchange 

2010 sau đó gõ lệnh setup /m:RecoverServer để cài đặt exchange 2010 dưới 

mode RecoverServer 
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Quá trình cài đặt sẽ diễn ra trong vòng khoảng 15 đến 20 phút, sau khi cài đặt 

thì sẽ hiện kết quả như bên dưới 

 
Tại server EX2010 mở EMC ->Organization Configuration ->Mailbox -> 

click phải lên database ―Mailbox Database 0069891456‖ chọn Properties 

 



195 

 

195 
 

 

 
Tại cửa sổ Mailbox Database 0069891456 Properties ->chọn tab 

Maintenance chọn This database can be overwritten by a restore ->click 

OK 

 
Làm tương tự cho các mailbox database còn lại và public folder còn lại trong 

trường hợp trên hệ thống của bạn nếu có. 

d. Phục hồi mailbox database từ bản backup 

Tại server EX2010 mở Windows Server Backup click Recover 
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Trong Recovery Wizard tại trang Getting Started chọn A backup stored 

on another location và click Next 

 
Tại trang Specify Location Type chọn Remote Shared Folder và click Next 

 

 
Trong trang Specify Remote Folder nhập \\DC2008\C$\Backup và click 

Next 

file://DC2008/C$/Backup
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Tại trang Select Backup Date click Next 

Tại trang Select Recovery Type chọn Applications sau đó click Next 

 
Tại trang Select Application chọn Exchange và click Next 

 
Tại trang Specify Recovery Options chọn Recover to original location sau đó 

click Next 
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Trong trang Confirmation click Recover 

 
Trong trang Recovery Progress click Close 
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e. Kiểm tra sau khi phục hồi 

Tại server EX2010 mở EMC ->Organization Configuration ->Mailbox 

chọn tab Database Management thì ta sẽ thấy database Mailbox Database 

0069891456 đang ở trạng thái Dismounted 

 
Click phải lên database này và chọn Mount Database 

 
Sau đó tại máy EX2010 ta mở Internet Explorer và truy cập với tài khoản 

mshome\tech01 
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Sau khi kiểm tra lại thì ta thấy rằng user tech01 đã có thể truy cập được 

mailbox sau khi phục hồi server Exchange 2010 
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BÀI 12: BẢO VỆ EXCHANGE SERVER 2010 

Mã bài : 19.12 

Giới Thiệu 

Trong phần này chúng ta sẽ tìm hiểu và thực hiện cách phân quyền cho các 

user trong hệ thống Exchange Server 2010 

Mục tiêu 

- Phân quyền quản lý các cấu hình trên exchange server 2010 

- Phân quyền quản lý thông tin mailbox và distribution group 

Hình 12.1.Mô Hình LAB 

 
1. Yêu cầu 

Mô hình lab sẽ bao gồm 3 máy: 

o DC2008: đóng vai trò server AD2008 đã được chuyển đổi các role từ 

DC2003 qua 

o EX2010: đóng vai trò server EX2010 trong hệ thống và đã được chuyển đổi 

các mailbox, public folder và system folder từ EX2003 qua. 

o EX2010-2: đóng vai trò server exchange thứ 2 trong hệ thống 

2. Phân quyền quản lý server Exchange cho user  

Tại server EX2010 mở Active Directory Users and Computers ->click 

Microsoft Exchange Security Groups ->click phải lên Server Management 

chọn Properties 
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Tại hộp thoại Server Management Properties chọn tab Members ->click 

Add 

 
Trong hộp thoại Select Users, Contacts, Computers, Service Accounts, 

or Groups gõ tech03 dưới trong ô Enter the object names to 

select(examples) ->click Check Names ->click OK 

 
Tại cửa sổ Server Management Properties click OK để hoàn tất quá 

trình add user tech03 vào nhóm Server Management 

 
  3 . Cấu hình quyền quản lý mailbox, group cho user  

Tech01 và Tech02 Tại server EX2010 mở Exchange Management Shell và 

gõ lệnh bên dưới New-RoleGroup –Name SupportDesk –roles “Mail 

Recipients”, “Mail Recipient Creation”, “Distribution Groups” ->nhấn 

Enter 
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Mở Exchange Management Console ->Tools Box ->double click lên Role 

Based Access Control (RBAC) User Editor 

 
Đăng nhập với tài khoản mshome\administrator chọn SupportDesk -

>click Details 

 

 
Dưới phần Members click Add 
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Tại hộp thoại xuất hiện chọn user Tech01 và Tech02 click Save 

 

 
4. Kiểm tra sau khi cấu hình 

Tại server EX2010-2 đăng nhập với user Tech03 và mở Exchange 

Management Console ->Organization Configuration ->Mailbox ->click 

phải lên database trên server EX2010 và chọn Properties 

 
Chọn tab Limits và bỏ chọn ô Issue warning at(KB) click OK thì ta thấy 
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rằng user Tech03 có thể chỉnh sửa tính năng cấu hình trên Exchange Server 

2010 

 
Tại EMC click chọn Hub Transport dưới phần Organization 

Configuration. Tại tab Accepted Domains ->click phải lên domain 

mshome.com chọn Properties 

 
Tại đây ta có thể thấy rằng user Tech03 không thể chỉnh sửa các thông tin 

cấu hình tại đây 

Click Cancel để thoát ra 
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Tại EMC mở rộng phần Recipient Configuration ->Mailbox ->double 

click lên user Sales01 và thử chỉnh sửa một số thông số thì ta thấy rằng user 

Tech03 không thể chỉnh sửa thông tin của các mailbox tại đây. 

Click dấu X trên góc phải màn hình để đóng EMC lại và logout server 

EX2010-2 

Tại server EX2010 mở Internet Explorer truy cập trang website  

https://webmail.mshome.com/ecp đăng nhập với tài khoản mshome\tech01 

trong phần Mailboxes click sales01 sau đó click Details 

 
Trong phần Organization nhập thông tin Sales Dept vào ô Department -

>click Save 

https://webmail.mshome.com/ecp
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Click Public Groups chọn nhóm sales và click Details 

 

 
Trong phần Description nhập Sales Dept ->click Save 

 
Sau khi chỉnh sửa maibox và public groups thì ta thấy rằng quá trình chỉnh 

sửa thông tin không gặp lỗi bất kì lỗi nào. Đến đây ta có thể kết luận quá trình 

cấu hình và phân quyền cho các user đã phù hợp theo yêu cầu đưa ra. 
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